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Getting Started with TI-Nspire™ CX Il Handhelds

The TI-Nspire™ CX Il and the TI-Nspire™ CX Il CAS are the newest handhelds in the TI-
Nspire™ family of products. Featuring a backlit colour display and a slimmer form, the
handhelds provide touchpad navigation, dynamic graphing and interactive computer
features.

The handhelds and the TI-Nspire™ software share the same functionality, enabling you
to transfer class assignments from the handheld to the computer or transfer
documents to the handheld when you need to be mobile. Start assignments at school,
and then finish the work at home, taking advantage of the software’s full-colour
display and easy-to-use navigation. Use the software to download the latest software
and handheld operating system updates as they become available to ensure you have
the latest enhancements.

This guide covers the following TI-Nspire™ CX Il handhelds:
e TI-Nspire™ CX Il / TI-Nspire™ CX Il CAS

e TI-Nspire™ CX II-T / TI-Nspire™ CX II-T CAS

e TI-Nspire™ CX II-C CAS

e TI-Nspire™ CX Il EZ-Spot

While they operate identically in many ways, there are a few distinctions. If there are
differences between the Numeric, Exact Arithmetic, or CAS handhelds, it is pointed out
and the appropriate operation is described.

About Maths Modes

TI-Nspire CX Il handhelds perform calculations in one of three modes: Numeric, Exact
Arithmetic, or Computer Algebra System (CAS).

Numeric mode supports results in terms of floating point numbers, integers, and
stacked fractions only.

Exact Arithmetic mode supports results in terms of floating point numbers, integers,
stacked fractions, 7, e, radicals /, and other constants such as In(5) and sin(2).

CAS mode supports the same results as Exact Arithmetic as well as symbol
manipulation such as x+x, and CAS functions such as symbolic factoring, solving
equations, limits, and indefinite integration.

The maths modes that are available will depend on which TI-Nspire CX Il handheld
model you have:

Handheld Model Numeric Exact Arithmetic CAS
TI-Nspire CX Il v
TI-Nspire CX 1l CAS /1 v v
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Handheld Model Numeric Exact Arithmetic | CAS
TI-Nspire CX II-T V2 v
TI-Nspire CX II-T CAS /1 v v
TI-Nspire CX 1I-C CAS /1 v v

1 CAS mode turned off

2 Exact Arithmetic mode turned off

TI-Nspire™ CX Handheld Keys

Use the TI-Nspire™ Touchpad as you would a laptop touchpad. You can also press the
outer edges to move right, left, up and down.

Removes menus or dialogue boxes from the
screen. Also stops a calculation in progress.

Opens the Scratchpad for performing quick

calculations and graphing.

Moves to the next entry field.

Makes the next character typed upper-case.

(et] Provides access to the function or character
shown above each key. Also enables shortcuts in

combination with other keys.

Turns on the handheld. If
the handheld is on, this key
displays the home screen.

Opens the Document menu.

Displays the application or
context menu.

Deletes the previous

character.
Displays stored variables.

Evaluates an expression,
executes an instruction or selects a
menu item.

Note: A p symbol on a key indicates access to multiple options. To access an option,
press (2] repeatedly or use the arrow keys on the Touchpad. Press or click to

select the option.

Preparing the TI-Nspire™ CX Il Handheld for Use

The TI-Nspire™ CX Il handheld comes equipped with a Li-ion rechargeable battery. The
handheld also comes with the following accessories:

e Standard mini-A to mini-B USB cable for transferring files to another handheld
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e Standard A to mini-B USB cable for transferring files to and from a computer and
for charging the battery

Charging the Handheld

» Using one of the following options, charge the battery for at least four hours to
ensure optimum performance.

- Connect the handheld to a computer using a standard A to mini-B USB cable.
To download software that includes a driver, go to education.ti.com/software.

- Connect to a wall outlet using a Tl wall adapter (sold separately).

- Ifin a classroom setting, place the handheld or multiple handhelds in a TI-
Nspire™ CX Docking Station or a TI-Nspire™ Docking Station.

Note: The TI-Nspire™ CX Il handheld has a Deep Sleep feature to maximise battery life
during extended storage periods. To put the handheld in Deep Sleep mode, press and
hold down the blue reset button on the back of the handheld for at least 4 seconds. To

wake the handheld from Deep Sleep mode, press for at least 4 seconds or apply
USB (computer or wall adapter) or Docking Station power. After waking the handheld,

you can turn it on anytime by pressing [@ton].

Note: For more information about recharging batteries, see Configuring TI-Nspire™
Handhelds.

Turning On the TI-Nspire™ CX Il Handheld for the First Time

After charging the battery, press to turn on the handheld. A progress bar is
displayed while the operating system loads. Next, choose preferences for language and
font size when prompted.

Note: To turn the handheld off, press [ct] [@Fon]. The settings and memory contents
are retained.

Using Automatic Power Down™

To prolong battery life, the Automatic Power Down™ (APD™) feature turns off the
handheld after three minutes of inactivity. When this happens, press to turn the
handheld on and return to the last document or last menu accessed. To change the

default setting, press to access the Handheld Setup screen where you can
change the Power Standby setting.

Note: For more information about setting up the handheld, see Configuring Handhelds.
Choosing a Language

After the OS is loaded, select a preferred language.

Change Language

Language: | English (U.5.) | » |

Cancel
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1. Press p to open the drop-down list.

2. Press ¥ to scroll through the languages, and then press or to select a
language.

3. Press to highlight the OK button, and then press [§] or to save the
language selection.

Choosing a Font Size

Next, select a font size for the display.

Handheld Setup
Font size: [Veaum ] ¥]
Fower Standby: | 3 Minutes n

Hibemate: [4Days | 7]
Pointer Speed: n

[C] Enable tapping to click

Cancel

1. Press ) to open the drop-down list.
2. Press ¥ to highlight the font size, and then press (3] or to select it.
3. Press to highlight the OK button, and then press [ 3] or [enter].

The Welcome! screen opens.

Welcomel

The next screen is the # home for the TI-MNspire™
CH 1l handheld. Here you can add applications to
your open documents.

The center of the Touchpad can be used to select
or grab. Click to select OK now.

QK

4. To continue, press (] or to select OK.

The Home screen opens.
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Scratchpad Documents

A Calculate
B Graph

5 Settings...

HUNENB®

Adjusting the Brightness of the Backlighting

The screen on the TI-Nspire™ CX Il handheld is backlit making it easier to use in all
lighting conditions. By default, the brightness setting is medium. To adjust the
backlight brightness:

e Dimmer: Press and hold [etn] and tap [=].
e Brighter: Press [ctr] and tap [+].
Using the TI-Nspire™ Touchpad

Use the Touchpad to navigate or complete any task that can be completed using the
arrow and Enter keys. Use the Touchpad to navigate in two ways:

e Use it like a computer touchpad by moving your fingertip in a sliding motion on the
centre area of the Touchpad to activate and move the mouse pointer. Click or tap
the centre of the Touchpad to select a menu option or complete an action.

e Press the arrow keys on the outside edge of the Touchpad to nudge the mouse

pointer up, down, left or right, then click or press to complete an
action.

If you hold down an arrow key, the mouse pointer continues to move in that
direction.

Note: If the mouse pointer is visible on a command or file, click or tap in the centre
of the Touchpad to select that command or file. If the command or file is highlighted,
move the pointer over that item or press to select it.

When working in an application, use the Touchpad to access more information about
problems. For example, hovering over a Graphs & Geometry object displays
information about variables used in that object and about tools that are available.

Some users prefer to customise their Touchpad settings; to speed up or slow down
their pointer, or to enable tap to click. To change the default settings for the Touchpad,
see Configuring Handhelds.
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Understanding the Scratchpad

Use the Scratchpad to make quick calculations and graphs without affecting the
current TI-Nspire™ document. For example, when you need a quick way to test a
calculation before you add it to a document, you can open the Scratchpad application
and perform the calculation. Then, you can either discard the calculation or add it to a
document. For more information about the Scratchpad, please see Using the
Scratchpad.

Using the Home Screen
The Home screen provides a starting point for all activities performed on a hand-held:

¢ Opening the scratchpad for quick calculations and graphing
e Creating new documents

¢ Opening and managing existing documents

e Defining settings and viewing status

e Viewing hints for operating the handheld

e Accessing recent documents

e Returning to the current document
Note: Press to toggle between the Home screen and the current document.

Home Screen Options

Menu Option Purpose

Scratchpad

Use the Scratchpad menu options to open a Calculator or Graph application without
affecting your document.

While in Scratchpad, press to toggle between Scratchpad applications: Calculate
and Graph.

Calculate Opens the Scratchpad with a Calculator application active. From
the Home screen, type [A].

Graph Opens the Scratchpad with a Graph application active. From the
Home screen, type .

Documents
To select options for working with documents, press the associated number or use the

Touchpad to select an icon then press [3] or [enter].

New Opens a new TI-Nspire™ document with available applications
listed.

6 Getting Started with TI-Nspire™ CX Il Handhelds



Menu Option Purpose

Browse Opens the file browser where you can open existing TI-Nspire™
documents or send files to others.

Recent Lists the five most recently saved documents.

Current Goes to the document that is currently open.

Settings Check the status of the handheld and change settings.

Application icons
To add a new page to the current document, select an application icon. If no
document is open, a new document opens with the selected application on a new

Spreadsheet

page.
Calculator Adds a page to a document for entering and evaluating maths
x + expressions.

o

Graphs Adds a page for graphing and exploring functions.

_+_

Geometry Adds a page for creating and exploring geometric shapes.
Lists & Adds a page for working with data in tables.

Data & Statistics

Adds a page and provides tools used to visualise sets of data in
different types of plots and provides tools for manipulating data
sets to explore relationships between the sets of data.

Notes Provides text editing functions for adding text to TI-Nspire™

documents for use as notes or to share with other users.
Vernier Adds a page for collecting and analysing data from sensors or
DataQuest™ probes.

To learn more about applications and documents, see Working with Documents on TI-
Nspire™ hand-helds.

Getting Started with TI-Nspire™ CX Il Handhelds
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The TI-Nspire™ CX Il Handheld Screen

When you are working in a document on a handheld, icons at the top of the screen
provide information about the status of handheld operations and provide an easy way
to change settings. The icons are described below.

“B.67

Icon Function

O Page scrolling arrows - Use the touchpad to click these arrows and scroll
through the pages in a document.

Page tab - Labels the problem number and page number of the active page.
For example, a label of 1.2 identifies Problem 1, Page 2. If problems are
named, hover the pointer over a tab to view the page name.

*Doc | Document name - Shows the current document name. An asterisk by the
document name indicates changes were made since the document was last
saved. Click the name to open the Documents menu.

Press to Test - Indicates that the handheld is in Press-to-Test mode.

Login status - Shows whether the handheld is searching for an access point
(blinking), found an access point (solid), not communicating, connected and
ready to log in (a blinking arrow) or logged in and charged (a solid arrow). Click
here to view Settings & Status.

»)

CAPS | shows status of the [eshift], [ctr], and caps, keys.

RAD | Angle Mode - Shows an abbreviation of the angle mode (Degrees, Radians or
Gradians) in effect. Hover the pointer over the indicator to see the full name.

Note: Click the indicator to toggle between RAD and DEG modes.

E Settings & Status - Shows an indicator of the current charge level of the
battery. Hover the pointer over the indicator to read the status as a

8 Getting Started with TI-Nspire™ CX Il Handhelds



Icon Function

percentage. Click the icon to open the Settings & Status menu.

E Close document - Click the icon to close the current document. If information
is unsaved, save or discard when prompted.

Using Hints

Hints are quick tips available throughout the software on the handheld. There are
several easy ways to access Hints:

e Press [ctn] [H9].

e Some dialogue boxes contain a question mark icon. Click this icon to open Hints for
that task.

To scroll through the Hints, use the Touchpad or arrow keys:
e To page down, press [t ] [3].

e To page up, press [ctr] [9].

e To go to the end of the Hints file, press [etn] [1].

e To go back to the beginning of the file, press [etn] [7].
Using Keyboard Shortcuts

Use the following keyboard shortcuts to perform common functions. You can also
perform all functions by selecting the options from menus.

Getting Help

Open Hints @

Editing Text

Cut (51

Copy @

Paste @

Undo @ [Z]
(etr]

Redo (etrt]

Getting Started with TI-Nspire™ CX Il Handhelds 9



Toggle approximate and exact results

Python Editor and Shell: Add a new line after the
current line.

(etn] [enter]

English: Change key to include appropriate accent
Chinese: Insert character

Inserting Characters and Symbols in a document

Display character/symbol palette

(en] (&)

Underscore

(en] (=]

Display math template palette

lel{g

Backslash (\)

(esniry] (=]

Manual data capture point

(en] (]

Clear [etr]
Caps Lock (etrt ]
Store @

Square brackets

(en] [

Curly brackets

(en] D)

Display Trig symbol palette

Equals symbol

Display pi symbols palette
(m, /, 6, and so on)

Display equality/inequality palette
(> <, #5,2,and | )

Display marks and letter symbols palette
R1s$° %"\
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Square root

(en] (]

log @
n (]
ans @ E]

Managing Documents

Open document menu

Open document

(en] (0]

Close document

(etn] (W)

Create new document

(e ] (N]

Insert new page

(en] (1]

Select application

(] (K]

Save current document

(] (s]
(en] (€]

Navigation

Top of page

Python Editor and Shell: Moves cursor to the
beginning of the first line in the program.

End of page

Python Editor and Shell: Moves cursor to the end of

the last line in the program.

Page Up

(en] [9)

Page Down

(en] (3]

Up a level in the hierarchy

(@] a

Getting Started with TI-Nspire™ CX Il Handhelds
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Down a level in the hierarchy (etn] w

Context menu for selection
Extends selection in direction of arrow Any arrow

Python Editor and Shell: Indents text on the current
line or selected lines or navigates between inline
prompts

Navigating in Documents

Displays previous page @ Y|
Displays next page (et ] p
Displays Page Sorter @ -
Exits Page Sorter (o] »
Switch between applications on a split page (etrt ]
Moves focus backward within page

Python Editor and Shell: Dedents text on the current
line or selected lines or navigates backwards between
inline prompts

Wizards and Templates

Add a column to a matrix after the current column

t

Add a row to a matrix after the current row

Python Editor and Shell: Add a new line after the

current line.

Integration template
Derivative template (=]
Math template palette or @ [E]

Fraction template @ [E]
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Modifying Display

Increase contrast

(en] (]

Decrease contrast

(en] (=)

Power off

(etn] [on]

Application-Specific Shortcuts

Notes/Program Editor/Python Editor: Select all

Press-to-Test: Select all items in the dialog

Program Editor/Python Editor: Check syntax and store

(en] [B)

Program Editor/Python Editor: Find

(en ] (F]

Geometry/Graph: Hide/Show Entry Line

Lists & Spreadsheet/Program Editor/Python Editor:
GoTo

(en] (G]

Program Editor/Python Editor: Find and Replace

(en] (H]

Calculator/Program Editor/Python Editor and Shell: (etr1)
Beginning of line
Calculator/Program Editor/Python Editor and Shell: (etn]

End of line

Notes: Insert math expression box

(etn] (M)

Notes: Insert chemical equation box

(en ] (E]

Open the Scratchpad

I

Lists & Spreadsheet: Recalculate

Program Editor: Check syntax, store program and paste
program name in Calculator (after clearing current line
in Calculator)

Python Editor: Check syntax, save program and

(o] [R)

Getting Started with TI-Nspire™ CX Il Handhelds
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execute in Python Shell

Python Shell: Rerun last program

Geometry/Graphs/Lists & Spreadsheet: Add Function (etn]
Table

Program Editor/Python Editor and Shell: Add/remove
comment symbol

Group/Ungroup applications on a page @ @ /@ @
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Using the Scratchpad
The Scratchpad is a feature of the TI-Nspire™ CX handheld that lets you quickly:

e Evaluate math expressions.

e Graph functions.

Opening and Closing the Scratchpad

» From the Home screen, press to open the Scratchpad.

The first time you open the Scratchpad, a blank page opens with the Calculator
active.

@ | A Scratchpad rap [I] X

> Press to alternate between the Calculate and Graph pages.

Using the Scratchpad 15



& | M Scratchpad rap [l X
Define cr.rb(n)=n3 Done
cub(S) 27
| Iﬂ' Scratchpad RAD @ X
6.65 Ay
11 /1l (\) =cub (\) -
Tt 1 10
565

> Press to see the Scratchpad Calculate or Scratchpad Graph menu. These
menus are subsets of the TI-Nspire™ menus for the Calculator and Graphs
applications. For complete listings of those menus, see the documentation for
those applications.

> Press to close the Scratchpad.

Calculating with Scratchpad

From the Scratchpad Calculate page, enter a maths expression on the entry line, then
press to evaluate the expression. Expressions are displayed in standard
mathematical notation as you enter them.

Each evaluated expression and result becomes part of the Scratchpad history, displayed
above the entry line.

Entering Simple Maths Expressions
Note: To enter a negative number, press (@] and then type the number.
Suppose you want to evaluate 28, 43

12

1. Select the entry line in the work area.

2. Type2 8 to begin the expression.
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-8

Press ) to return the cursor to the baseline, and then complete the expression by
typing:
[x] 43 (5] 12
28.4317)
Press to evaluate the expression.
The expression is displayed in standard mathematical notation, and the result is
displayed on the right side of the page.
28_43 2752
12 3
Note: You can force a decimal approximation in a result by pressing [ctr]
instead of [enter].
28 43 917.333

12 4

LY 1

\ /

Pressing [ ctrl ] forces the approximate result.

Note: Results formatting can also be adjusted in settings. For more information about
customising settings, see Configuring the TI-Nspire™ CX Handheld.

Inserting Items from the Catalogue

You can use the Catalogue to insert functions and commands, symbols and expression
templates into the entry line.

1.

Press to open the Catalogue. By default, the first tab is displayed, which lists all
commands and functions in alphabetical order.

103 25 3K [4+F 5wk 6 @

[] =wizards On

[abs(Expr) |
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2. If the function you are inserting is visible in the list, select it and press to
insert it.

3. If the function is not visible:
a) Press a letter key to jump to the entries that begin with that letter.
b) Press w or a as necessary to highlight the item you are inserting.

c) Clicka numbered tab to list functions by category: maths functions, symbols,
maths templates, library objects, and value for standard measurement units.

d) Press to insert the item into the entry line.
Using an Expression Template

Templates help you enter matrices, piecewise functions, systems of equations,
integrals, derivatives, products and other maths expressions.

>

For example, suppose you want to evaluate n=3

1. Press to open the Template palette.

o
ad=]

2. Select 1B=0 to insert the algebraic sum template.

The template appears on the entry line with small blocks representing elements
that you can enter. A cursor appears next to one of the elements to show that you
can type a value for that element.

3. Use the arrow keys to move the cursor to each element’s position, and type a value
or expression for each element.

S W

4. Press to evaluate the expression.
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25

Inserting Expressions Using a Wizard

You can use a wizard to simplify entering some expressions. The wizard contains
labelled boxes to help you enter the arguments in the expression.

For example, suppose you want to fit a y=mx+b linear regression model to the
following two lists:

Press (1] to open the Catalogue and show the alphabetic list of functions.

Click inside the list, and then press L] to jump to the entries that begin with “L".

If the Wizards On option is not checked, press to highlight Wizards On.

{1,2,3,4,5}

{5,8,11,14,17}

1.

2.

3. Press w as necessary to highlight LinRegMx.
4.

5. Press to change the setting.

6. Press to highlight LinRegMx again.

Lbl -
lem(

left(

LibPriv

LibPub
libShortcuty

E] [ =wizards On

[LinReghix X, ¥ [,[Freq] [,Category, Include]] |

|1 23 348 4 5nf 5E|-

left(

LibPriv
LibPub
libShortcuty

lim(
limit(

|z| [ =wizards On

\LmReng X, Y [,[Freq] [,Categoty, Include]]

T 20 3% 4+F 50f |6 @ LinRegMx function in a non-CAS or Exact

Arithmetic handheld

LinRegMx function in a CAS handheld
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7. Press [enter],

A wizard opens, giving you a labelled box to type each argument.

Linear Regression (a+bx)

SaveregEanto: [n | ]
Frequency List: l:m
Include Categories: l:m

OK Cancel

8. Type{1,2,3,4,5}as XList.
9. Press to move to the Y List field.
10. Type {5,8,11,14,17} as Y List.

11. If you want to store the regression equation in a specific variable, press [tab], and
then replace Save RegEqn To with the name of the function variable (f1 through
f99).

12. Click OK to close the wizard and insert the expression into the entry line.

The expression is inserted along with statements to copy the regression equation
and display the variable stat.results, which will contain the results.

LinRegMx {1,2,3,4,5},{5,8,11,14,17},1: CopyVar stat.RegEqn,f1: stat.results

The Scratchpad then displays the stat.results variables.

U Scratchpad RAD @ X
LinRegMx {1,2,3,4,5 },{5,8,11,14,17 },1: Co
"Title" "Linear Regression (mx+b)"
"RegEqn" "m- x+b"
"m" 3.00
"b" 2.00
T 1.00
"r 1.00
"Resid" ey
|
N

Note: You can copy values from the stat.results variables and paste them into the
entry line.

Viewing the History

Each evaluated expression and result becomes part of the Scratchpad history, displayed
above the entry line.

> Press a or w to scroll through the history.
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Copying a History Item to the Entry Line

You can quickly copy an expression, sub-expression or result from the history into the
entry line.

1. Press a or w to move through the history and select the item that you want to
copy.

2. Optionally, select part of the expression or result by using in combination
with the arrow keys.

73.1428571429
approx

3. Press to copy the selection and insert it into the entry line.

5815 1614
7

42

Clearing the History

When you clear the history, all variables and functions defined in the history retain
their current values. If you clear the history by mistake, use the undo feature.

» From the Actions menu, click Clear History.
—or—
Press (1] [5].

All expressions and results are removed from the history.
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Editing Scratchpad Expressions

Although you cannot edit a Scratchpad Calculate expression in the history, you can copy
all or part of an expression from the history and paste it into the entry line. You can
then edit the entry line.

Inserting Elements into the Entry Line
1. Press , 4 ), a or w to position the cursor in the expression.
The cursor moves to the closest valid position in the direction that you press.

2. Type the elements or insert them from the Catalogue.

Selecting Part of an Expression
You can delete, cut or copy a selected part of an expression.
1. Press 4, p, a, or w to move the cursor to a starting point in the expression.
2. Press and hold and press 4, p, a or w to select.

- To delete the selection, press .

- To cut the selection to the Clipboard, press [ctn] [X].

- To copy the selection to the Clipboard, press [etr] [C].

- To paste the selection to a new entry line in Scratchpad, press [ctn] (V).
Graphing with the Scratchpad
1. Press to open the Scratchpad Graph page if it is not already open.

By default, the entry line is displayed. The entry line displays the required format
for typing a relation. The default graph type is Function, so the form f1(x)=is
displayed.

If the entry line is not shown, press Ctrl + G or press to display the
entry line and type an expression to graph.

2. Press > Graph Entry/Edit and select a graph type.

For example:

e To graph an equation for a circle, press > Graph Entry/Edit > Equation >
Circle > (x-h)2 + (y-k)Z = rZ or press (1]. Fill in the equation and
press to draw the circle.

e Tograph a function, press > Graph Entry/Edit > Function or press

[mend) (3] (1].

The entry line changes to display the expression format for the specified graph
type. You can specify multiple relations of each graph type.

22 Using the Scratchpad



3. Type an expression and any other parameters required for the graph type.

) 42 :|

4. Press to graph the relation, or press w to add another relation. If necessary,

you can use press to choose a tool on the Window/Zoom menu and adjust
the viewing area.

When you graph the relation, the entry line disappears to show an uncluttered view
of the graph. If you select or trace a plot, the relation that defines the plot is
displayed on the entry line. You can modify a plot by defining a relation or by
selecting and changing the graph.

As you graph multiple plots, the defining relation is displayed for each. You can
define and graph a maximum of 99 relations of each type.
5. Usethe key to explore and analyse the relation to:
e Trace the relation.
e Find points of interest.
e Assign a variable in the expression to a slider.

Viewing the Table

» To display a table of values corresponding to the current plots, press > Table

> Split-screen Table ([menu] (1]).

& \J | Scratchpad ra0 [I] X
6.654Y = 00 v |~

X

P W N 2O

v

iy
=]
=
Xl
0
=
> ||
P W NS

“6.65 O. 4«

» To hide the table, click the graph side of the split screen, and then press >
Table > Remove Table ([menu] (7] [2]). You can also press Ctrl + T.
» To resize columns, click the table and press > Actions > Resize ([mend] (1] [1]).

» To delete a column, edit an expression, or edit table settings, click the table and

press > Table ([meny] [2]).
Changing the Appearance of the Axes

As you work with graphs, the Cartesian axes are displayed by default. You can change
the appearance of the axes in the following ways:
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1. Press and choose the Zoom tool to use.
2. Select the axes and press [ctr] to activate the Attributes tool.

a) Press a or w to move to the attribute to change. For example, choose the end
style attribute.

b) Press qor ) to choose the style to apply.

c) Change any other attributes of the axes as required for your work, then press
to exit the attributes tool.

3. Adjust the axes scale and tick mark spacing manually.

a) Click and hold one tick mark, then move it on the axis. The spacing and number
of tick marks increases (or decreases) on both axes.

b) To adjust the scale and tick mark spacing on a single axis, press and hold
and then grab and drag a tick mark on that axis.

4. Change axis end values by double-clicking them and typing new values.

Adjust the location of the axes. To move the existing axes without resizing or
rescaling them, click in and drag an empty region of the screen until the axes are in
the desired location.

6. Change the axes’ scales by pressing > Window/Zoom > Window Settings

([mend] (4] (1)).

Type the values of your choice over the current values for x-min, x-max, y-min, y-
max, Xscale and Yscale and click OK.
7. Press > View > Hide Axes ([mend] [2] [1]) to hide or show the axes.
e |f the axes are shown on the page, selecting this tool hides them.
e If the axes are hidden on the page, selecting this tool redisplays them.

Tracing a Plot

Graph Trace moves through the points of a graphed function, parametric, polar,
sequence or scatter plot. To enable the trace tool:

1. Press > Trace > Graph Trace ([menu] (5] [1]) to move across the plot in Trace

mode.

m,l Scratchpad RADmX
i\ 6654,

665 f1:(0,0)
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2. (Optional) To change the trace step increment for tracing, press (3].

After you type a different step increment, the Graph Trace tool moves across the
graph in steps of that size.

3. Use Graph Trace to explore a plot in the following ways:
e Move to a point and hover to move the trace cursor to that point.

e Press ¢ or ) to move from point to point on the function’s graph. The
coordinates of each point traced are displayed.

* Press a or w to move from one plot to another. The point’s coordinates
update to reflect the new location of the trace. The trace cursor is positioned
on the point of the new graph or plot with the closest x value to the last point
identified on the previously traced function or graph.

e Type a number and press to move the trace cursor to the point on the plot
with independent coordinates nearest the typed value.

e Create a persistent point that remains on the graph by pressing when the
trace point reaches the point you want to label. The point remains after you
exit Graph Trace mode.

Notes:

e The string undef is displayed instead of a value when you move over a point
that is not defined for the function (a discontinuity).

e When you trace beyond the initially visible graph, the screen pans to show the
area being traced.

4. Press or choose another tool to exit Graph Trace.
Finding Points of Interest

You can use the tools on the Analyse Graph menu to find a point of interest in a
specified range of any graphed function. Choose a tool to find zero, the minimum or
maximum, the point of intersection or inflection or the numeric derivative (dy/dx) or
Integral on the graph.

1. Select the point of interest that you want to find on the Analyse Graph menu. For

example, to find a zero, press (6] (7).

non-CAS and
Exact Arithmetic

Zero @ [i] @ [I]
Minimum @ [Z] @ @
Maximum (6] (6] B3)
Intersection (6] (4] (6] (4)
Inflection Not applicable (6]

CAS
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non-CAS and
Exact Arithmetic

dy/dx (6] (5 (6] (6]
Integral (6] (6] (6]
Analyse Conics (6] (6]

The icon for the selected tool is displayed at the top left on the work area. Point to
the icon to view a tooltip about how to use the selected tool.

CAS

2. Click the graph you want to search for the point of interest, then click a second
time to indicate where to start the search for the point.

The second click marks the lower bound of the search region and a dotted line is
displayed.

Note: If you are finding the derivative (dy/dx), click the graph at the point (numeric
value) to use for finding the derivative.

3. Press qor p to move the dotted line that marks the search region, and then click
the point at which you want to stop the search (upper bound of the search region).

W Scratchpad RADmX

ﬂ \ 6654,
\ ) £1(0)=(c+1)%-1

lower bound? . 665

4. Press at the point to start the search. The tool shades the range.

If the search region you specified includes the point of interest, a label for the point
is displayed. If you change a graph that has points of interest identified, be sure to
check for changes in points of interest. For example, if you edit the function on the
entry line or manipulate a plot, the point where the graph intersects zero can
change.

The labelled points of interest remain visible on the graph. You can exit the tool by
pressing or choosing another tool.

Working with Variables in the Scratchpad

Scratchpad variables are shared between Scratchpad Calculate and Scratchpad Graph,
but not with any TI-Nspire™ documents. If you use the same name for a Scratchpad
variable and a variable in a document, no conflict occurs unless you attempt to copy
expressions between documents and the Scratchpad.
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Saving the Scratchpad Contents

You can save the Scratchpad Calculate page, the Scratchpad Graph page or both as a
TI-Nspire™ document.

1. Press [docv], and then select Save to Document ([doc+] [A]).
2. Press [enter],

The Save to Document dialogue box opens.

Casmbaln=sd RAD X
Save to Document... 0

Select Scratchpad contents

to a document:

Calculate label
'2
Sraph -1
——+—+—+— Save fo: 2l
-10 b
O New Document

(® Current Document

Cancel

0w |
Select the page or pages to save.

4. If a document is open, select either New or Current document.
Click Save.

¢ If you selected to save to a current (open) document, the Scratchpad pages are
added to the document.

e If you selected to save the Scratchpad pages to a new document, the pages are
converted to an unsaved document. To save the document:

- Press > Save. The Save As dialogue box opens.

- Type a name for the document.
- Select Save to save the new document.

Clearing Scratchpad Contents

Complete the following steps to delete the calculations and graphing work from the
Scratchpad application.

1. Press > Clear Scratchpad ([doc+] [B]).
2. Press to delete the Scratchpad contents.
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Working with Documents on TI-Nspire™ CX Il Handhelds

All of the work you do with a TI-Nspire™ CX Il handheld is contained in one or more TI-
Nspire™ documents, which you can share with other handheld users and with those
using the computer software.

e Each document is divided into at least one, and up to 30, problems.
e Each problem contains at least one, and up to 50, pages.
e Each page can be divided into as many as four work areas.

e Each work area can contain any of the TI-Nspire™ applications (Calculator, Graph,
Geometry, Lists & Spreadsheet, Data & Statistics, Notes and Vernier DataQuest™).

Opening a Document

1. From the Home screen, select Browse.

—or—

Press (2].

The file manager opens.

*Unsaved Document

[¥1 Unsaved Document

Dv Iy Documents 342K
[ 7th Period Geometry 0K
4 Algebra | 0K
7 Algebra Il 0K
D" Examples 291K
3 MyLib 35K

R o

2. Navigate to the file you want to open.

e Press w to highlight the document name, and then press (%] or to open
the document.

e |If the file is in a folder, press w to highlight the folder, and then press or
to open the folder.

3. Press to open the Documents menu to access options for working with the
open document.

Creating a New Document
1. From the Home screen, select New.

—or—
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Press [1].
You can also press [ctr] [N].

A new document opens with a list of applications.

1 Add Calculator

i 2 Add Graphs
2 Add Geometry
B 4 Add Lists & Spreadsheet
[l 5 Add Data & Statistics

6 Add Notes

7 Add Vernier DataQuest™
B 8 Add Widget
) 9 Add Program Editor »

Note: The tab at the top left of the screen indicates that this is the first page of the
first problem.

2. Use w and a to highlight the application you want to add to the page, and then
press to open the page.

Saving Documents

To save the document in the My Documents folder:

1. Press to open the Documents menu, then select File > Save.

Note: You can also press (1] (4] or [e] [S] to save a document.

The Save As dialogue box opens.

Save As...

Save In:| My Documents |__‘—|+
MName Type Size

[ 7th Period Geometry Folder =
[ Algebra | Folder

Y Algebra 1l Folder -

File Mame: |Document‘|

Save Cancel
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If you are saving the document for the first time, you will be asked which folder to
save it to and what to name the document. The default folder is My Documents.

2. Type a name for the document.
3. Click Save to save the document in the My Documents folder.

Saving a Document in a Different Folder

To save the document in a different folder:

1. From an open document, press ] (5.

The Save As dialogue box opens.

2. Press to navigate to the list of existing folders. The first folder in the list
is selected.

3. Use the w and a to scroll through the list of folders.
4. To select and open a folder, press .
5. Type a name for the document.

6. Click Save to save the document in the selected folder.

Saving a Document in a New Folder

To save the document in a new folder:

1. From an open document, press ] (5].

The Save As dialogue box opens.

Save As... o @ New folder
’ icon
Save In:| My Documents | O
MName Type Size
4 MyLib Folder i
Y MyWidgets Folder
~ Type new
. o (2]

i [Foldent (3 | Folder i, folder name
File Mame: ‘Documenﬂ ‘

Save Cancel

2. Press until the New Folder icon is highlighted, then press to create a
new folder.

The new folder is added to the bottom of the list of existing folders. By default, the
folder name is “Folderl”.

3. Type a name for the new folder, then press to save.

30 Working with Documents on TI-Nspire™ CX Il Handhelds



4. Press again to open the folder.
The File Name field becomes active.

5. Type a name for the document.

6. Click Save to save the document in the new folder.
Working with Applications
Options for working with applications include:

e Creating a new document and selecting an application
e Adding a new page and application to an open document
e Adding multiple applications to a page in a document

Adding an Application
There are multiple ways to add an application to a page:

e When creating a new document, use the Touchpad or corresponding numbers to
select an application from the list of applications.

e Toadd a new page and application to an open document, press [ctr] and then
select an application from the list.

For example, press to add the Graph application to the page. The application
opens in the work area.

el 1.1 13 *Doc FADD X

£1(x)<] =

~6.67

You can also press [@Fon], and then select an application from the Home screen by
clicking one of the following application icons:

X+ Calculator
il
\y Graphs
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Geometry

Lists & Spreadsheet

Data & Statistics

= a7

Notes

Vernier DataQuest™

Using Multiple Applications on a Page

You can add up to four applications to each page.

When you create a new document, it contains space to add one application. If you need

to add more than one application to a page, you can change the layout to
accommodate as many as four applications.

You can choose a standard layout, provided as a menu item or you can customise a
layout to suit your needs.

Choosing a Standard Page Layout

1. Press (5] [2] to display layout options.

*Doc

f1x) Documents
—E 1 File »

& O s

] 1 Layout1 | Custom Split

@ Select Layout v

B 3 Layout3 3 SelectApp (Ctrl+K)
M0 B 4 Layoutd L Swap Applications
)
3

5 Layout5 3 Delete Application
B 6 Layoute 3 Delete Page

[B 7 Layout7 7 Group (Ctrl+4)
BB 8 Layout8 i Ungroup (Ctrl+6)

2. Press the number that corresponds to the layout you want.

For example, press to create a two-pane layout, divided vertically on the page.

32 Working with Documents on TI-Nspire™ CX Il Handhelds



< EEN" *Doc rao [l X

71(x)<]

Press menu

Sy X

T
=
o
=

-6.67

3. Press [ctn] to move between panes. Bold lines around the pane indicate that
the pane is active.

4. Press [menu], then press the number of the application you want to add the new
pane. For example, press (4] to add the Lists & Spreadsheet application.

o 1.1 I3 *Doc rap [I] X
6.67 YV A B -
]

1 x| 2

-10 1 0
3 )

4
‘:_ A4
-6.67 4 1 3

Note: If you need to change the layout of the page to add or delete applications,
you can do so at any time. When deleting an application, select the application to
be deleted first.

Creating a Custom Page Layout

If the standard layouts do not meet your needs, you can customise the space allotted
to applications on a page.

1. Press (5] to display layout options.
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*Doc

Documents

B 1 File ’

z 2 E.dit 1 Custom Split

E‘ 3 View 5 gelect Layout 4

(i 4 Insert 3 Select App  (Ctrl+K)
10 7EE 5 Page 4 Swap Applications

C 6 Refre:s Delete Application

{37 Setting Delete Page

& 8 Login. - Group (Ctri+d)

o9 Prs‘is_: Ungroup (Ctrl+6)

2. Press [1] to select the custom split option.

The standard layout is displayed with a divider between the application panes. Use
the arrows (E'.':;.;) in the middle of the divider to adjust the size of the panes.

71lx)=

i) Press menu
pot

=10 1 1
Use + or - to choose a layout

-6.67

3. Press a, w, or ) to move the divider to adjust the height or width of the panes in
the layout.

4. Press [+] or [=] to select a defined layout:
e Pressing [=] returns to a full page layout.

* Pressing once switches layout from a vertical layout to a horizontal layout.
Press [=] to go back to a vertical layout.
* Pressing twice adds a third pane to the page. Pressing multiple times

enables you to choose between a vertical and horizontal page layout with three
panes.

* Pressing five times adds a fourth pane to the page. Press [=] to cycle
through the previous layout options.
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5.

6.

Press %] or to accept the layout dimensions.

Press [ctrl ] to move between panes. Bold lines around the pane indicate that
the pane is active.

Swapping Applications on a Page

If you want to change the position of applications on a page with multiple applications,
you can do so by “swapping“ the positions of two applications.

1.

Press (5] Page Layout [4] Swap Application.

The selected application is surrounded by a heavy, flashing black border and the
Swap App cursor £J is displayed on the screen.

Note: On a two-pane page layout, the selected application automatically swaps
position with the opposite pane. Press or to complete the swap.

Press a, w,  or p to position the cursor over the application you are targeting to
swap.

Press (] or to complete the swap.

Note: Press to cancel the swap.

Grouping Applications

To group up to four application pages into a single page:

1.
2.

Select the first page in the series.

From the Document menu, select Page Layout > Group.

Press (7).

The next page is grouped with the first page. The page layout automatically adjusts
to display all the pages in the group.

Ungrouping Pages

To ungroup the pages:

1.
2.

Select the grouped page.

From the Document menu, select Page Layout > Ungroup.
—or—

Press (5] (8].

The material becomes individual pages for each application.

Deleting an Application from a Page

1.

Click the application you want to delete.
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2. From the Document menu, select Page Layout > Delete Application.
—or—

Press (5] [5].

The selected application is deleted.

If you want to undo the delete, press Ctrl-Z.
Using the Application Menu

The Application menu enables you to select tools for working with a specific
application. Each application has a unique menu.

Using the Application Menu
1. From a blank page, press to display the Application menu.

The menu displays applications that you can add to the page.

Fress menu

2. Press the number of the application you want to add to the page. For example,
press (4] to add the Lists & Spreadsheet application.

Doc

%z} 1 Add Calculator

i 2 Add Graphs
2 Add Geometry
B 4 Add Lists & Spreadsheet
D 5 Add Data & Statistics

6 Add Notes

7 Add Vernier DataQuest™
B 8 Add Widget
[ 9 Add Program Editor »
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3. Press to display the Application menu, which lists the options for working
with the current application.

The example below displays the Application menu for the Lists & Spreadsheet
application.

sl 1 Actions ¥

ETH =
td; 2 Insert 4 c D

133 3 Data » |
N 4 Statistics ¥

5 Table
| IS

2

3

4

5]
X

Context Menus

Context menus display options that are specific to the selected object or the current
cursor location.

Using the Context Menu

> To access a context-sensitive menu from an application, press (menu].

In the example below, the context menu displays options available for the selected
cell in Lists & Spreadsheet.

1 Cut
A 2 Copy D i
- 3 Paste
! | 5 Delete Cell
2 6 Fil
3 7 Variables ’
8 Resize »
4 9 Summary Plot
5 A Quick Graph -
rB Color » | qa D

Working with Problems and Pages

The options on the Documents menu let you:

e Save a document
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Access edit functions such as undo, redo, cut, copy, paste and delete

Move between pages and open the page sorter view for documents with multiple
pages

Modify page layout, insert pages or problems, delete pages and change settings
Add problems, pages and applications to open documents

Access page layout options

Adding a Problem to a Document

Adding problems to a document enables you to reuse variable names. A document can
contain as many as 30 problems. To add a new problem:

1.

Press (4] (1] to open the Insert options.

® -

br‘oblem

BEH > Page (Ctrl+)

= E1 F'l? 3 Calculator
; ég ‘\E!iti.:zmd Graphs

5 Geometry
2 i Insei g Lists & Spreadsheet
3 M? Data & Statistics

& 6 Refng Notes
. {7 Settig Vernier DataQuest™
5 £ 8 Logitp widget

m & 9 Pres B Program Editor »

A new problem with one page is added to the document. The tab at the top left of
the screen indicates that this is the first page of the second problem.

Press menu

Press to open the Application menu, then press the number corresponding to
the application you want to add to the new page.
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Viewing and Reordering Pages in a Document

The Page Sorter displays all of the problems in your document and all pages within
each problem in thumbnail format. You can use the Page Sorter to rearrange and
delete pages, copy a page from one problem and paste it into another and apply
templates to pages.

Viewing Multiple Pages with the Page Sorter

Although the handheld typically displays the pages in your document one at a time, the
Page Sorter lets you see all of the problems in your document and all pages within
each problem in thumbnail format. You can use the Page Sorter to rearrange and
delete pages and copy a page from one problem and paste it in another.

Opening the Page Sorter from a Document

> Press [ctn] a.
The Page Sorter screen displays all of the problems and pages in the current
document.
*Unsaved Document o
* Problem 1 ik
- o

¥ Problem 2

Reordering Pages in a Problem

Use the Page Sorter (press A) to move a page within a problem with multiple
pages:

1. Press the ¢ or p key to select the page you want to move.

A heavy border around the page indicates that it is selected.
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*Unsaved Document m

¥ Problem 1 R
- T
¥Problem 2

2. Either press and hold or press [ctr ] until the grab cursor 2y is displayed.

3. Press {, ), a or w to move the page to the desired position.
4. Press (3] or to finish the move.

Note: You can press to cancel.

The page moves to the new location within the problem and the counter adjusts
accordingly.

Copying a Page to Another Problem

To copy a page from one problem to another in the same document:
1. Press [ctrl] a to open Page Sorter.

2. Press {, ), a or w toselect the page you want to copy.

A heavy border around the page indicates that it is selected.

*Unsaved Document m

¥ Problem 1 R

- T

¥Problem 2
L]

3. Press [en] [C] to copy the page.
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4.

Press {, ), a or w to select the desired position in the problem where you will
paste the page. The copied page will be placed after the page you select.

Press (et ] (V] to paste the page in the new location.

The page is copied to the new location within the problem and the counter adjusts
accordingly.

Note: If the page contains variables with the same names as the new problem, a
conflict may occur. Rename the variables if necessary.

Copying a Page to Another Document

To copy a page from one document to another document:

1.
2.

10.
11.

Press [ctn] a to open the Page Sorter.
Press 4, p, a or w to select the page you want to copy.

A heavy border around the page indicates that it is selected.

Press [t ] [C] to copy the page.
Press to open My Documents.

Press a and w to highlight the folder containing the document you want to copy
the page to.

Press ) to open the folder.

—or—

Press (3].

Press the a and w keys to highlight the document.

Press (%] or to open the document.

Press (¢t ] a to display the Page Sorter.

Press ¢, ), a or w to move the page to the desired position in the document.

Press (et ] [V] to paste the page in the new location.

The page moves to the new location within the problem and the counter adjusts
accordingly.

Copying, Pasting and Deleting Problems

You can copy and paste a single problem from one location to another within the same
document or a different document. You can also delete a problem from the document.

Copying and Pasting a Problem

To copy and paste a problem:

1.

Open the Page Sorter.
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Press [ctn] a.

—or—
Press (3] [3].

*Jnsaved Document m
¥ Problem 1 Eh
*Problem 2

2. Select the problem. If there are multiple problems, you can press to
collapse the Page Sorter to list the problems by number and title only.

3. Press [en] [C].

4. Go to the location where you want the problem to appear.
5. Press [en] [V].

A duplicate problem is placed in the new location.
Deleting a Problem
To delete a problem from the document:
1. Select the problem from the Page Sorter.

2. Press [en] [X].

The problem is deleted from the document.
Renaming a Problem
To rename a problem:
1. With the document active, open the Page Sorter.

Press [ctr] a.

2. Select the problem name.

3. Press [ctri] [menu],

4. Select Rename and type the name.
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5.

Press [t ] [S] to save the change.

Adding a Page to a Problem

Each problem can contain up to 50 pages. To add a new page to a problem:

>

Press [ctrl ] or [en] (1] to add a blank page and select an application.
—or—

Press to display the Home screen, then point to the application you would
like to add to the new page and click or tap.

A new page is added to the current problem.

Mode
Time Based
Rate

S samplesfs
Duration

405

Note: The tab at the top left of the screen indicates that this is the second page of
the second problem.

Moving Through Pages in a Document

Tabs display up to three multiple pages. When a document contains more than three
pages, arrows appear on the left and right of the tabs.

Use the following keys to navigate through your documents.

(ctn] 4 displays the previous page.
(etn] p displays the next page.
[ar] a displays the Page Sorter.

[en] w displays the previous view.

Use the Touchpad to click on the arrows that appear on either side of the tabs to
show additional pages in a document containing more than three pages.

Working with Documents on TI-Nspire™ CX Il Handhelds 43



Managing Documents

My Documents is a file manager in which you store and organise your documents. The
example below illustrates the My Documents screen with its main parts labelled.
Following the screen, you can find descriptions of each labelled part.

*Unsaved Document

g [+] Unsaved Document
] My Documents 342K——@
g—- F_"l Examples 291K
T MyLib 35K
0—- O3 MyWidgets 17K
9 stopwatch 17K

(1] Expanded folder

@ Current, unsaved document
@ Collapsed folder

e System status indicators

@ File size

Browsing Files in My Documents

To open My Documents:

> Press (2].

Note: If you are working in a page, press [ctr ] a [ctr] a.

The My Documents screen opens, displaying all folders and files on the handheld.
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ocument

(£ Unsaved Document
| Wy Documents

[ Examples

[ 00 Getting Started

o

O o1 Percentage Explorer
O oz Introducing Functions

(3 03 Linear Equations Explorer

342K
291K
104K
9K
26K
17K

-

e To sort columns by name or size, click that column head. Click again to change
the sort from ascending to descending.

e To scroll through My Documents, click or grab the scroll bar.

e To expand a single folder, point to the folder and click on the folder icon or
press (<] ). To collapse, click again or press ¢

e To expand all folders, press (7]. To collapse, press (8].

Renaming Folders or Documents

To rename a folder or document:

1. Press the a and w keys to highlight the document or folder you want to rename.

2. Press 2].

Unsaved Document

I My Documents
] Examples

7 MyLib

] MyWidgets

342K
291K
35K
17K

E stopwatch|

| 7]

The document or folder name is highlighted.

3. Type a new name and press to complete the change.

Note: Press to cancel.
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Creating Folders
You can create folders two different ways:

* You can create a folder when you save a new document: The Save and Save As
menu commands allow you to enter a new folder name for the document.

e You can create a folder directly from the My Documents screen. Press (.
Type a name for new folder, press (%] or to add it.

File and Folder Naming Conventions

Folder names must be unique. File and folder names can be very long and can include
almost all characters, including spaces and punctuation.

Note: If you are planning to transfer these documents to your computer for use in the
TI-Nspire™ software, it is best to use names that are accepted on your computer. Avoid
punctuation, \, / or symbols.

Deleting Documents and Folders

1. Press a and w to highlight the document or folder you want to delete.

2. Press [otr] (6.

—or—
Press (%],
& Size

Unsaved Do 3 Cut

- 4 Copy
[ My Documet 342K

. Y 5 Paste

[ Examples CJRIE 291K
O MyLib 7 Rename 35K

[ MyWidgsts 8 MNew Document 17K

. 9 New Folder
7k

A dialogue box opens, confirming that you want to delete the file or folder.
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*Unsaved ument

Name

1 Unsaved Document

'stopwatch'?

O O

O

5 » Confirm Document Delete

Are you sure you want to delete document 1K

1 stopwatch 17K

& Size

2K

ELS

3. Press[§] or to select Yes.
The document is deleted.

Duplicating Documents and Folders

Use Copy [etr] (€] and Paste to duplicate documents and folders.

To copy a document to another folder, select the desired folder and then paste.

Recovering Deleted Documents

Most operations performed in My Documents can be undone. Press [ct] [Z] (Undo) to
cancel the last operation until the deleted document is restored.

Closing a Document

1. Toclose a document, press (1] (3.

—or—

Press (et ] [W].

If you have changed the document, you will be asked whether you want to save

those changes.

2. Click Yes to save the document, or click No to abandon the changes.

Understanding the TI-Nspire™ Tools

This section provides an overview of the tools used when working with TI-Nspire™
documents on a handheld, including variables, catalogue, symbols and maths

templates.
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Creating TI-Nspire™ Variables

Variables can be any portion or attribute of an object or function created within an
application. Examples of attributes that can become variables are the area of a
rectangle, the radius of a circle, the value contained in a spreadsheet cell or the
contents of a column or a function expression. When you create a variable, it is stored
in memory within the problem. You will find more information about variables in the
chapter titled Using Variables.

Using the Catalogue

Use the catalogue to access a list of TI-Nspire™ commands and functions, units,
symbols and expression templates. Commands and functions are listed alphabetically.
Commands or functions not beginning with a letter are found at the end of the list (&,
/, +, - and so on). To open the catalogue:

1. From an open document, press to open the catalogue.
TEd 2z 232 4= s5ef 6@
amortThbl( -

and

angle(

ANOVA, 3
ANOVAZwWay -4
Ans

approx( -

@ []=Wizards Cn

\amortTblNPmt, N, I, PV, [Pmt], [FV], [PpY], [ 3]

2. Press the number key corresponding to the appropriate tab.

For example, press to show a list of maths functions.
3. Press ¥ until the item you want to insert is highlighted.

A syntax example for the selected item is displayed at the bottom of the screen.

Note: To see additional syntax examples of the selected item, press and then
press to maximise or minimise the Help. To move back to the selected item,

press (tab].
4. Press to insert the item.
About the Catalogue Window

The catalogue window uses these tabs to categorise commands, special characters
and templates in documents:
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Contains all commands and functions, in alphabetical order

1

2 Iz Contains all maths functions

3 Provides the values for standard measurement units

4 of Provides a symbol palette for adding special characters

5 mff Contains maths templates for creating two dimensional objects, including
product, sum, square root and integral

& Shows public library (LibPub) objects

Using Wizards

Some catalogue functions have a wizard to help you enter function arguments. To use

a wizard, press until the Wizards On box is highlighted. Press [$] or to
select the checkbox.

'| 2.[2 B,EE 4°°B° 5lul{g 5

Mumber -
Angle

List

[ matrix
Create

Transpose
Determinant

2]

-

|Matrix |

Entering Special Characters

The symbol palette contains a subset of the objects found in the catalogue. To open
the symbol palette:

1. Inan open document, press [ctr ] [c).
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2. Press 4, p, a or w to select a symbol.
3. Press to insert the symbol.
Entering Maths Expressions

Use maths expression templates to create two-dimensional objects such as
summation, integral, derivative and square root. To open the maths expressions
palette:

1. In an open document, press [v].

CRE B CIE I A
o (58] o0 [i] Bel T ¢ s [

Iy 3 Co

2. Press 4, p, a or w to select an expression.

3. Press (%] or to insert the expression.

Entering International Language Characters

Use the @ key to enter specially accented or punctuated characters in applications
such as Notes that allow text input.

1. Open an application such as Notes that allows text input.

2. Type the desired text.
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3. Position the cursor after the letter that you want to accent. For example, “e” while
in the French locale.

Press @ on the keypad. Notice that the “e” changes to “é”. Keep pressing @ until you

find the accented version of e that you want. Press [ ] or the next letter of your text
to accept the character and continue typing.
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Working with Images

Images can be used in TI-Nspire™ applications for reference, assessment and
instructional purposes. You can add images to the following TI-Nspire™ applications:

e Graphs & Geometry
e Data & Statistics
e Notes

e Question, including Quick Poll

In the Graphs & Geometry and Data & Statistics applications, images are set in the
background behind the axis and other objects. In the Notes and Question applications,
the image is set at the cursor location in-line with the text (in the foreground).

You can insert the following image file types: .jpg, .png or .bmp.

Note: The transparency feature of a .png file type is not supported. Transparent
backgrounds are displayed as white.

Working with Images on a Handheld

On a handheld, images can be copied from one document to another or resized or
repositioned within a document. You can also delete images from a document.

You cannot add or insert images into a document when working on a handheld.
However, you can transfer a document containing an image from your computer to a
handheld.

Note: If there is not enough storage on the handheld to accommodate a document
containing an image, an error message is displayed.

Copying an Image

Complete the following steps to copy an image from one document to another or from
one page to another within the same document.

1. Open the document that contains the image you want to copy.
2. Select the image.

e Inthe Question or Notes applications, move the cursor over the image and

press (2].
e Inthe Graphs & Geometry application, press 1] 2] 2.
e Inthe Data & Statistics application, press (3] (6].
A border appears around the image.

3. Press [ctn] [menu], and then click Copy. You can also press [t ] [C].

4. Open the document where you want to paste the image or select a page in the
current document.
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Note: If you open a new document, you will be prompted to save and close the
current document.

5. Press [ctn] (V).

Note: If pasting an image into the Graphs & Geometry application, press [enter], and
then press [ctr] (V).
The image is copied to the page in the document.

Repositioning an Image

Complete the following steps to reposition an image on a page.

1. Open the document and navigate to the page that contains the image.

2. Select the image.

¢ Inthe Question or Notes applications, move the cursor over the image, then
press, hold and release . The image appears shaded.

* Inthe Graphs & Geometry application, press 1 2] 2].
e Inthe Data & Statistics application, press (3] (6].
A border appears around the image.

3. Move the image.
¢ Inthe Question or Notes applications, move the cursor to the new location and
press .

¢ Inthe Graphs & Geometry or Data & Statistics applications:

- Press and hold until the cursor changes to a four-sided arrow ( ‘-I_' ).
The image floats in the background and the border changes to a dashed
line.

- Move your finger over the Touchpad to move the image to the new
location, and then press [§] or to place the image.
Resizing an Image
Complete the following steps to resize an image on a page.

1. Open the document that contains the image.
2. Select the image.

¢ Inthe Question or Notes applications, or in Quick Poll, move the cursor over the
image and press, hold and then release . The image appears shaded.

e Inthe Graphs & Geometry application, press 1] 2] 2.
e Inthe Data & Statistics application, press (3] (6].

A border appears around the image.
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3. Move the cursor to one of the corners.

The cursor changes to a four-sided directional arrow ( x ).

Note: If you move the cursor to the edge of an image, the cursor changes to a two-
sided directional arrow. You can drag the image left or right to resize it, but the
image will become distorted.

4. Press .

The @] tool is enabled.

5. Move your finger over the Touchpad in any direction to resize the image.
A dashed line appears to indicate the new size.

6. To accept the new size, press or [enter],

Deleting an Image

Complete the following steps to remove an image from a page.

1. Open the document that contains the image.
2. Select the image.

¢ Inthe Question or Notes applications, move the cursor over the image, then
press, hold and release . The image appears shaded.

e Inthe Graphs & Geometry application, press (1] 2] [2].
e Inthe Data & Statistics application, press (3] (6].
A border appears around the image.
3. Press [ctn] [menu], and then select Delete.
The image is removed.

Note: In the Question and Notes applications, you can also press to remove a
selected image.
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Working in a TI-Nspire™ CX Premium Teacher Software
Classroom

If you are in a classroom where TI-Nspire™ CX Premium Teacher Software is used, you
will need to log in to class to communicate with the teacher’s computer. The teacher
can communicate with your handheld in the following ways:

e Send files
e Collect files
e Delete files

e Send Quick Polls and receive Quick Poll responses

The teacher can also pause and restart your handheld. When class is paused, you will
receive a message on your handheld. You cannot use your handheld until the teacher
releases the handheld from pause mode.

Using Wireless Communication Hardware

Teachers using TI-Nspire™ CX Premium Teacher Software in the classroom can attach
wireless cradles and/or network adapters to students' TI-Nspire™ CX handhelds. Those
handhelds can then link wirelessly to an access point attached to the teacher's
computer.

You can attach any the following devices to TI-Nspire™ CX handhelds:

e TI-Nspire™ CX Wireless Network Adapter - v2 (2.4 GHz or 5.0 GHz band)
e TI-Nspire™ Wireless Network Adapter (2.4 GHz)

Attaching a Wireless Adapter to a CX Handheld

Note: The battery in the handheld powers the wireless adapter.

1. Position the wireless adapter on top of the handheld so the connector on the
adapter lines up with the connector on top of the handheld.

Wireless network adapter (school-owned)

- Guides for aligning

- with handheld

0

-r;‘.--—'""_'_—'_;::h
et
v

Connector @

2. Slide the adapter into position, making sure the guides on the sides of the adapter
slide into the grooves on the sides of the handheld.
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Side view of handheld

Groove to align (D
wireless adapter

—

3. Firmly press the adapter into place so that the adapter sits on top of the handheld
as shown in the following illustration.

Note: The TI-Nspire™ CX handheld can be charged with the wireless adapter attached.
Connecting to the TI-Nspire™ CX Navigator™ System

To connect to the TI-Nspire™ CX Navigator™ network, you must log in to the network
from your handheld. Before you can log in, the teacher must complete the following
tasks:

e Start a class session on their computer.

e Provide you with the class network name, a username and, if necessary, a
password.

Note: Use this method to log in to the network if the operating system on the handheld
is version 3.2 or higher.
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Logging in to the Network
1. Attach a wireless adapter or wireless cradle to the handheld.
2. Ensure your TI-Nspire™ CX Il handheld is ready for login. (The 0 icon is blinking.)
3. Complete one of the following actions:
e From the Home screen, press (5] (5].
e From an open document, press (8].

The Login to Class dialogue box opens and the last network that was associated
with the wireless client appears.

@ CAS

Scratchpad Documents
Login to Class

Network: Select a Network

User Name: |jga|‘cia

Password: | abC|

Network Cancel

Note: If the handheld is connected to the computer with the USB cable, no network
names appear on the screen, and you can continue logging in.

4. If the name of the network that appears is correct, click Login. If the network is not
correct, click Network.

The handheld screens displays the last network the wireless client was attached to,
and also displays other networks within range.

i) CAS

Scratchpad Documents

TI-Nspire Networks

Network: | My_Classroom

Select a Network

My_Classroom

Algebrall

Calculus_lII
Classroom1

5. Select the network from the list, and then click Connect.
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The login screen shows the connection status and displays the network name when
the connection is successful.

6. Type your username and password.

7. Select Login.

The Login Successful screen opens.

Login Successful

You are logged in as user: John

TI-Nspire™ Handheld Login Status Icons

8. Click OK.

The icons on the TI-Nspire™ CX Il and TI-Nspire™ CX Il CAS handheld screens indicate
the communication status between the handheld and the access point, wireless
adapter, wireless cradle, or TI-Navigator™ network. The icons indicate status as
follows.

lcon Status Meaning

Blinking | The handheld is searching for an access point.

Solid The handheld has found an access point.

Solid The handheld is not communicating with the adapter or cradle.
Remove the handheld from the adapter or cradle, wait for the
icon to disappear, and then reattach the handheld to the adapter
or cradle.

Blinking | The handheld is connected to the network and is ready to login.

Solid The handheld is logged in to the network.

ele] a[»»

Understanding File Transfers

During a class session, the teacher can send files to student handhelds and collect or
delete files from student handhelds.
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Note: Before class starts, teachers can set up actions to send or collect files. When you
log in, the files are sent or collected. If the teacher set up actions to both send and
collect files, you will only see the dialogue box for the last action completed.

Opening Sent Files

When the teacher sends a file to your handheld, the Transfers Complete dialogue box
opens.

£} CAS

Scratchpad Documents
A C & 1 MNew
Transfers Complete

Folder: Algebra - €
Document: approxfrac.tns

» Click Open to open the file. If the teacher sent multiple files, this opens the last file
in the list.

Note: The files are received alphabetically by name, no matter which order the
teacher sent them in. The last file in the list is the last alphabetical file.

» Click Go To to go to the location on the handheld where the file was sent. The file
name is highlighted. You can open that file or navigate to another file. If the
teacher sent multiple files, the last alphabetical file in the list is highlighted.

» Click OK to dismiss the dialogue box without opening the file. Your handheld
returns to the state it was in when the message was sent.

Collecting or Deleting Files

Your teacher may collect or delete files from your handheld during a class session. For
example, teachers can collect homework assignments or delete certain files prior to a
test. When the teacher collects or deletes files, you receive a message on your
handheld.
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i CAS

Scratchpad Documents
A Calculate 1 New

d Transfers Complete

All files hawve heen transferred.

» Click OK to dismiss the message.
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Configuring Handhelds
This chapter provides information needed to:

* Maintain batteries used in the handheld.
e Change the default settings.

e Attach a wireless module when the handheld is used in the classroom.
Checking Battery Status
To check the status of the TI-Nspire™ Rechargeable Battery in a handheld:
1. Press [@lon].

The Home screen opens.
2. Press [5] (4] (Settings > Status).

The Handheld Status dialogue box opens.

Handheld Status

Batteries: 100%

‘ersion: 5.0.0.1297

Battery status is shown here.

Storage Capacity: 92.3 ME
Storage Awvailable: 91.8 ME

Metwork: Wireless client is not attached.

Login: Mot logged in.

3. Click OK or press to close the window.

Note: From an open document, press (4] ([doc+] > Settings & Status > Status).
Recharging the Handheld

To recharge the TI-Nspire™ Rechargeable Battery in a handheld, connect it to any of
the following power sources:

e A standard USB cable connected to a computer
e ATIUSB wall charger (sold separately)

e ATI-Nspire™ CX Docking Station if in a classroom setting
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The amount of time required to fully charge the battery may vary, but charging
normally takes about six hours. It is not necessary to remove the TI-Nspire™
Rechargeable Battery from the handheld to recharge it. The handheld operates
normally while it is attached to a charging source.

Recharging a Battery from a Computer

To recharge a handheld from a computer, a TI-Nspire™ USB driver must be installed.
USB drivers are standard with any TI-Nspire™ software, which includes:

e TI-Nspire™ CX Premium Teacher Software

e TI-Nspire™ CX CAS Premium Teacher Software
e TI-Nspire™ CX Student Software

e TI-Nspire™ CX CAS Student Software

To download software that includes a driver, go to education.ti.com/software.
Understanding the Priority of Power Sources

When the TI-Nspire™ Rechargeable Battery is fully charged, the handheld draws power
in the following order:

e First, from a connected external power source, such as:
- A computer connected through a standard USB cable
- An approved wall charger (sold separately)

e Second, from the TI-Nspire™ Rechargeable Battery

Disposing of Used Batteries Safely and Properly

Do not mutilate, puncture or dispose of batteries in fire. The batteries can burst or
explode, releasing hazardous chemicals. Discard used batteries according to local
regulations.

Changing Handheld Settings
Use the options on the Settings menu to change or view the following settings:

e Change language

e Settings (Document and Graphs & Geometry)
- Define or restore settings for open documents and the Scratchpad
- Define or restore default settings for the handheld

e Handheld Setup

e Status

e login

Note: Not all options are accessible at all times. Options that are unavailable are
disabled.
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Opening the Settings Menu
» From the Home screen, press [5] or use the Touchpad to select Settings.

The Settings menu opens.

Change Language...
Document Settings...
Handheld Setup...

Status...

Login...

Network...

Tl=Innovator Hub...
Restore Factory Defaults...

1
2
3
4
S
6
7
8

Changing a Preferred Language

Complete the following steps to change a preferred language:

1. From the Home screen, press or select Settings to open the menu.
2. From the menu, select Change Language or press .

The Change Language dialogue box opens.

Change Language

Language: | English (U.S.) | » |

Cancel

3. Press ) to open the drop-down list.
4. Press w to highlight a language, then press [ or to select it.

5. Press to highlight the OK button, then press [$] or to save the language
selection.

Customising the Handheld Setup
Handheld setup options enable you to customise options to suit your needs.

e Font size (small, medium or large).
e Power standby. (1, 3, 5, 10 or 30 minutes).
- Use this option to extend battery life.

- By default, the handheld automatically powers down after three minutes of
inactivity.

e Hibernate (1, 2, 3, 4, 5 days or never).
- Use this option to extend battery life.
- When hibernating, the handheld saves current work in memory.
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- When you turn the handheld on again, the system reboots and opens saved
work.

e Pointer speed (slow, normal or fast).

e Auto dim (30, 60 or 90 seconds and two or five minutes).

e Enable tapping to click.

Changing Handheld Setup Options

1. From the Home screen, press E] (Settings > Handheld Setup).

The Handheld Setup dialogue box opens.

Handheld Setup
Font Size: | Medium 4
Power Standby: | 3 Minutes ’
Hibernate: | 4 Days r
Fointer Speed: | Normal 4
Auto Dim: | 90 Seconds | P

|:’ Enable tapping to click

Cancel

N

Press until the desired category is highlighted.
3. Press ) to view the list of possible settings.

4. Press w to highlight the desired setting.

Press or to select the new setting.

When you have changed all the settings to suit your needs, press until OK is
highlighted, then press |§] or to apply your changes.

Customising Document Settings

o v

Document settings control how the handheld displays and interprets information in TI-
Nspire™ documents and in Scratchpad. All numbers, including elements of matrices
and lists, are displayed according to the document settings. You can change the default
settings at anytime and you can also specify settings for a particular document.

Document settings and their possible values are listed in the following table.
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Field Values
Display e Float
Digits e Floatl - Float12
e  Fix0 - Fix12
Angle e Radian
e Degree
e Gradian
Exponential | ¢ Normal
Format e Scientific
e Engineering
Real or e Real
Complex e Rectangular
e Polar
Calculation e Auto
Mode e Exact
e Approximate
Note: Auto mode shows an answer that is not a whole number as a
fraction except when a decimal is used in the problem. Exact mode
(CAS only) shows an answer that is not a whole number as a fraction
or in symbolic form, except when a decimal is used in the problem.
Exact ¢ On
Arithmetic o Off
Note: This option is only available on Exact Arithmetic handhelds.
CAS Mode e On
e Exact Arithmetic
o Off
Note: This option is only available on CAS handhelds and software.
Vector e Rectangular
Format e Cylindrical
e Spherical
Base e Decimal
e Hex
e Binary
Unit System | e SI
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Field Values

e Eng/US

Note: This option is only available on CAS handhelds and software.

Changing Default Document Settings

Complete the following steps to define default document settings for TI-Nspire™
documents and Scratchpad.

1. Save and close any open documents.
2. From the Home screen, press [5] [2] (Settings > Document Settings).

The Document Settings dialogue box opens.

Document Settings Document Settings
Display Digits: | Float 6 ] - Display Digits: | Float 5 ] -
g [Fagan V] N T D

Exponential Format:

Exponential Format: | Normal

Real or Complex: | Rea Real or Complex:

Calculation Mode: Calculation Mode: [Aue [ V]
Exact Arithmetic: CAS Mode: n
OK | Cancel OK | Cancel
Exact Arithmetic OS CAS OS

3. Press to move through the list of settings. Press a to move backward through
the list.

A bold line around a box indicates it is active.

4. Press p to open the drop-down list to view the values for each setting.

or [enter] to

5. Press the a and w keys to highlight the desired option, then press
select the value.

6. Click OK to save the settings as default settings that will be applied to all new TI-
Nspire™ documents and to Scratchpad.

Changing Document Settings in a TI-Nspire™ Document
Complete the following steps to change document settings for an open TI-Nspire™

document. The settings will also be applied to Scratchpad and used as the default for
all new documents.

1. From an open document, press [@ten] [5] [2] ([Glon] > Settings > Document
Settings).

The Document Settings dialogue box opens.
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Document Settings Document Settings

Display Digits: | Float & Display Digits: | Float 6

»

Angle: | Radian Angle: | Radian

Exponential Format: u Exponential Format: n
cestorcomte: [cea___[0]
Calculation Mode: u Calculation Mode: n
cose e [an 1]

OK Cancel QK Cancel

Exact Arithmetic OS CAS OS

2. Press to move through the list of settings. Press a to move backward
through the list.

A bold line around a box indicates it is active.

3. When you reach the desired setting, press ) to open the drop-down list to view
values for each setting.

4. Press the a and ¥ keys to highlight the desired option, then press [%] or to
select the value.

5. Click OK or press or to apply the new settings to the open document, and

to set as the default for new documents and Scratchpad.

Restoring Document Settings

Complete the following steps to restore the original factory settings to open or new
documents, and to the Scratchpad.

1. From the Home screen, press 5] (8] (Settings > Restore Factory Defaults).

The Restore Defaults dialogue box opens.

Restore Defaults

Restore all of the following to their factory default

values?

- Document Settings
- Graph
- Data &
- Handheld Setup

seometry Settings

Cancel

2. Click OK to restore settings to the factory default settings.

3. Press or click Cancel to return to the Home screen without making changes.

Configuring Handhelds

67



Customising Graphs & Geometry Settings

Graphs & Geometry settings control how information is displayed in open problems
and in subsequent new problems. When you customise application settings, your

selections become the default settings for all of your work in the Graphs and Geometry
applications.

Complete the following steps to change the Graphs & Geometry Settings and make
these settings the default for all new graphs and geometry documents and Scratchpad.

1. Open a document with the Graphs or Geometry application active.

2. Press (9] ([menu) > Settings).

The Graphs & Geometry Settings dialogue box opens.

Graphs & Geometry Settings

Display Digits: n -
sraphing Angle:
seometry Angle: | Degree n

[ Automatically hide plot labels

Show axes end values

v

OK Cancel

3. Press to move through the list of settings. Click p to open the drop-down list
to view the values for each setting.

Field Values

Display Digits Auto

Float

Floatl - Float12
Fix0 - Fix12
Graphing Angle |Auto

Radian

Degree
Gradian

Geometry Angle | Auto
Radian
Degree
Gradian

Grid No Grid
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Field

Values
Dot Grid
Lined Grid

4. Press w to view the values, then press (%] or to select a value.

In the lower half of the dialogue, select a tickbox to enable an option or clear a
tickbox to disable an option.

Tickbox

Operation when selected

Automatically

Plot labels display only when a plot is hovered, selected or

manipulation

hide plot grabbed.

labels

Show axis Displays a numeric label at the least and greatest values visible
end values on an axis.

Show tool Shows helpful information as you manipulate function graphs.
tips for

function

Automatically
find points of

Shows zeros, minima and maxima for graphed functions and
objects while tracing function graphs.

interest

Force Restricts the angles of a triangle to integer values as you create

geometric or edit the triangle. This setting applies only in the Geometry

triangle View with the Geometry Angle unit set to Degree or Gradian. It

angles to does not apply to analytic triangles in Graphing View or to

integers analytic triangles in the Analytic Window of the Geometry View.
This setting does not affect existing angles, and it does not apply
when constructing a triangle based on previously inserted
points. By default, this setting is deselected.

label points Applies labels (4, B, ..., Z, A1, B4, and so on) to points, lines,

and vertices of geometric shapes as you draw them. The
labelling sequence starts at A for each page in a document. By
default, this setting is deselected.

Note: If you create a new object that uses existing un-labelled
points, those point are not automatically labelled in the
completed object.

6. Choose one of the following options:

e To apply the settings to the open document only, click OK.

e Click Cancel to close the dialogue box without making changes.
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Viewing Handheld Status

The Handheld Status screen provides the following information about the current state
of the handheld:

e Battery status for the rechargeable batteries

e Software version

e Storage capacity and amount of storage available

e Network (if any)

e Your student login name and whether you are logged in
e About

Opening the Handheld Status Screen

1. From the Home screen, press (5] (4] (Settings > Status).

The Handheld Status screen opens.

Handheld Status

Batteries: 100%

“ersion: 5.0.0.1297
Storage Capacity: 82.3 ME
Storage Awvailable: 91.8 ME

Metwork: Wireless client is not attached.
Login: Mot logged in.

2. Click OK to close the Handheld Status screen.

Viewing Handheld Details

The About screen provides additional information about the handheld type, the
operating system (OS) version and the product ID.

1. From the Home screen, press (5] (4] (Settings > Status).

The Handheld Status screen opens.

2. Click About to view details about the handheld.
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About

Handheld Type: TI-Mspire™ CX ||

Math and Science Learning Technology
Copyright @ 2006-2018 Texas Instruments
All rights reserved.

Product 1D: 1D200080000000866460872A10C
Eoot ROM Version: 5.0.0.42

Eoot Loader Version: 5.0.0.54

Wisit education.ti.com for the latest versions. s’

QK

3. Click OK to close the About dialogue box.

4. Click OK to return to the Home screen.
Replacing TI-Nspire™ Rechargeable Batteries

When you replace the battery, complete the following steps to insert the TI-Nspire™
Rechargeable Battery into a handheld.

Note: Your handheld may not exactly match these illustrations.

1. Use a small screwdriver to release the panel from the back of the handheld.

3. Remove the old battery.
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4. Insert the rechargeable battery into its compartment.

Precautions for Rechargeable Batteries
* Do not expose batteries to temperatures above 140°F (60°C).
¢ Do not disassemble or mistreat batteries.

e Use only the charger recommended for the cell or battery, or the one that was
provided with the original equipment.

e Tl recommends that you use the USB cable included with this calculator. If you
choose to use a third-party power adapter with the Tl-supplied USB cable, you
should use an adapter that meets applicable safety and operational standards and
certifications, including UL and CE certifications.

Take these precautions when replacing rechargeable batteries:

¢ Replace only with a Tl approved battery.

¢ Remove the cell or battery from the charger or alternating current adapter when
not in use or being charged.

e Use of the battery in other devices may result in personal injury or damage to
equipment or property.

¢ Do not mix brands (or types within brands) of batteries. There is a risk of explosion
if the existing battery is replaced by one of the wrong type.

Disposing of Batteries
Do not mutilate, puncture or dispose of batteries in fire. The batteries can burst or

explode, releasing hazardous chemicals. Discard used batteries according to local
regulations.
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Connecting Handhelds and Transferring Files

This chapter describes how to connect one TI-Nspire™ CX Il handheld to another, how
to connect handhelds to a computer and how to transfer files between them.

The TI-Nspire™ handhelds have a USB port that enables connectivity with another TI-
Nspire™ handheld or with a computer.
Connecting Handhelds

You can use USB cables to connect two TI-Nspire™ handhelds or to connect a TI-
Nspire™ handheld to a computer.

TI-Nspire™ handheld mini-USB cable to connecttwo TI-Nspire™ USB connection cable to connect the

TI-Nspire™ handhelds. handheld to a computer.

Connecting Two TI-Nspire™ Handhelds with the Mini-USB Cable

The USB portis located on the top of the TI-
Nspire™ CX Il handheld on the right side when
holding the handheld with the screen facing you.

El

3| D0

S 1688

5]
0

1. Firmlyinsert either end of the mini-USB cable into the USB port.
2. Insert the other end of the cable into the receiving handhelds’s USB port.
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Connecting the TI-Nspire™ Handheld to a Computer

1. Firmlyinsert the mini-USB end of the cable into the port at the top of your
handheld.

2. Firmly insert the USB end of the cable into the USB port of the computer.
Transferring Files between Handhelds

You can send documents, Operating System (OS) files, and folders to another TI-
Nspire™ handheld.

Note: TI-Nspire™ CX handhelds must be running v4.5.1 or later of the OS in order to
transfer to or from TI-Nspire™ CX || handhelds.

Rules for Transferring Files and Folders
* You can transfer documents and OS files.

e Operating systems are not interchangeable between different handheld types. For
example, you cannot transfer a CAS operating system to a non-CAS handheld.

e If a document with the same name as the one you are sending already exists on
the receiving handheld, the document will be renamed. The system appends a
number to the name to make it unique. For example, if Mydata existed on the
receiving handheld, it would be renamed Mydata(2).

Both the sending and receiving handhelds will display a message that shows the
new name.

e There is a 255-character maximum length for a file name, including the entire
path. If a transmitted file has the same name as an existing file on the receiving
handheld and the file names contain 255 characters, the name of the transmitted
file will be truncated to enable the software to follow the renaming scheme
described in the previous paragraph.

e All variables associated with the document being transmitted are transferred with
the document.

e Transmissions will time out after 30 seconds.

Caution: Some older TI-Nspire™ handhelds cannot receive folders; only files. If you
receive an error in sending to an older TI-Nspire™ handheld, see Common error and
notification messages.

Sending a Document or Folder to Another Handheld
1. Ensure the two handhelds are connected.

2. Open the My Documents file browser and navigate to the file or folder you want to
transfer.

3. Press the a and ¥ keys on the Touchpad to highlight the document or folder you
want to send.

4. Press (6] to select Send from the Documents menu.
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5. The file transfer begins. A progress bar shows the status of the transfer. There is
also a cancel button in the Sending... dialogue box to enable you to cancel the
transmission while it is in progress.

At the end of a successful transmission, the message

“<Folder / File name> transferred as <Folder / File name>.” is displayed. If the file
had to be renamed on the receiving handheld, the message will show the new file
name.

Receiving a Document or Folder

No action is required by the user of the receiving TI-Nspire™ handheld. Handhelds are
automatically powered on when the cable is attached.

At the end of a successful transmission, the message “<Folder / File name> received.”
is displayed. If the file had to be renamed, the message will show the new file name.

Caution: Some older TI-Nspire™ handhelds cannot receive folders; only files. If you
receive an error in sending to an older TI-Nspire™ handheld, see Common error and
notification messages.

Cancelling a Transfer

1. To cancel a transmission in progress, press Cancel on the sending handheld. The
user of either handheld can also press [esc].

2. Press or to cancel the transmission error message.
Transferring Files between Computers and Handhelds

In the Documents Workspace, teachers and students can use the “drag and drop”
method to quickly transfer files and folders from a computer to a handheld or transfer
files from a handheld to a computer.

Note: You must be running v5.0 or later of the TI-Nspire™ software in order to transfer
to or from TI-Nspire™ CX Il handhelds.

1. Connect the handheld to the computer using a standard A to mini-B USB cable.

2. Inthe TI-Nspire™ software, open the Documents Workspace.

3. Inthe Documents Toolbox, click to open the Content Explorer.
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Documents Toolbox

[~ g =] Computer panel

»

Computer

Lockin: |TH-Nspire X ~| G

Name & Size
. Dictionary
. Downloads

, Examples

. Images

| Live Presenter Recordings
. MyLib

, MyWidgets

. Screen Captures

. Stacks Connected Handhelds

TI-Nspire™ CX Connected Handhelds x

Lookin: |Connected Handhelds ~ I

Name ¥
H THNspire CX 1 8FID

4. Navigate to the folder that contains the file you want to transfer.

e To transfer a file from a handheld to the computer, click the file, and then drag
the file to a folder in the Computer panel.

e Totransfer a file from the computer to a handheld, click the file, and then drag
the file to a connected handheld.

Note: Those using the TI-Nspire™ CX Premium Teacher Software or the TI-Nspire™ CX
Navigator™ Teacher Software can also use options in the Content Workspace to
transfer files from a handheld to a computer.
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Using the Save to Handheld Option

In the Documents Workspace, you can also use the Save to Handheld option on the File
menu to transfer a file to a connected handheld when you want to save a file to a
specific folder on the handheld.

1. Ensure the handheld is connected to the computer.

2. In the Computer panel, navigate to the folder where the file is located.
3. Click the file.
4

Click File > Save to Handheld. The Save to Handheld dialogue box opens.

& saveto Handheld ===

Lookin: [Connected Handnelds |

Name
B Ti-Nspire cx 1l 8FOD

Documentname: |Documentl.ins

| cancel |

5. Double-click the handheld name, and then navigate to the folder where you want
to save the file.

6. Click Save. The file is saved to the selected folder and the Save to Handheld
dialogue box closes.

Handling Errors Resulting from Sending Folders

If you receive an error after attempting to send a file, it may mean the receiving
handheld has an operating system that does not support the transfer. To resolve this,
update the receiving handheld’s OS and try the send again.

Common Error and Notification Messages

(S’I:‘own Message and Description
Sending “This folder structure is not supported on the

handheld | receiving handheld. The receiving handheld’s OS may
need to be updated, which you can do by selecting
Send OS from the My Documents menu.”

OK

If you get an error when sending a folder to an older TI-Nspire™ handheld, try
updating the OS on the receiving handheld. If the error persists, you may have
to send the files individually.
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Shown

Message and Description

on
Sending “Transfer failed. Check cable and try again.™
handheld OK
This message is displayed if a cable is not attached to the sending handheld’s
link port. Remove and then reinsert the cable and try the document
transmission again.
Click OK to cancel the transmission message.
Note: The sending handheld may not always display this message. Instead, it
may remain BUSY until you cancel the transmission.
Sending “Receiver does not have enough storage space for
handheld file transfer.“
OK
This message indicates that the receiving handheld does not have enough
storage to accept the file being transmitted.
The user of the receiving handheld must free space to obtain the new file. To
do this:
e Delete unneeded files.
e Store files on a computer for later retrieval, and then delete them from
the TI-Nspire™ handheld.
Sending “<folder>/<filename> transferred as
handheld <folder>/<filename (#) .
This message is displayed at the end of a successful transfer when the file had
to be renamed because a file already exists on the receiving handheld with
the original name. The transmitted file is renamed by appending a number to
the end of the name. Rename numbering always begins with (2) and can
increment by one, as needed.
Sending “<folder>/<filename> transferred as <folder>/<new
handheld filename>."
This message indicates that a new folder was created on the receiving
handheld to contain the transmitted document.
Receiving “<folder>/<filename (x)> received.“
handheld This message indicates that the receiving handheld has a document with the
same name as the document being sent.
Receiving “<new folder>/<new filename> received.“
handheld This message indicates that a new folder has been created to contain the
transmitted document.
Receiving “Transfer failed. Check cable and try again.™
handheld OK

This message indicates that the cable is not correctly attached to the
receiving handheld’s link port. Remove the cable then reattach it and try the
transmission again.
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Shown

on Message and Description

Click OK to cancel the transmission message.
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File Management

The TI-Nspire™ CX Il Handheld comes equipped with 128 MB of Flash storage. The
operating system uses part of that storage, and saving new documents on the
handheld further reduces the amount of available storage over time. To avoid or
resolve storage space issues, use one of the following options:

Delete documents and folders you no longer use.
Back up files and folders to another handheld or computer.

Reset the storage, which deletes ALL files and folders on the handheld.

Checking Available Storage

Complete the following steps to view the amount of storage (in bytes) that is available
on your handheld.

1.

3.

From the Home screen, select Status from the Settings menu.

Press (5] (4].

The Handheld Status window opens.

Handheld Status

Eatteries: 'IOO%

‘ersion: 5.0.0.1297
Storage Capacity: 92.3 MEB
Storage Awailable: 91.8 ME

Metwork: Wireless client is not attached.

Login: Mot logged in.

About 0K

View the Storage Available field to determine how much storage is available on the
handheld.

Click OK to return to the Home screen.

Freeing Storage

To free or recover storage, delete documents and/or folders from the handheld. To
keep the documents and folders for later use, transfer them to another handheld or to
a computer using the TI-Nspire™ software.

Deleting Files from the Handheld

1.

2.

Press to open the My Documents file browser.

Press a or w to select the folder or document you want to delete.
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3. Press [®].

—or—

Press [ctr] (6].

A dialogue box opens, asking you to confirm the deletion.

Name A Size

] Examples 196K
Confirm Document Delete

Started™?

Yes Cancel

[ 1ceCreamCone 4K

=N

[ Getting Started 104K

-

hd

4. Press to confirm or to cancel.

The folder/document is permanently removed from the handheld.

Backing up Files to Another Handheld

1. Connect the two handhelds using the USB-to-USB connectivity cable.

2. Press (2] to open My Documents on the sending handheld.
3. Press the a and ¥ keys to highlight the document you want to send.
4

Press menu], and then select Send.

—or—

Press [ctrl ] (2].

5. When the file transfer is complete, a message is displayed on the receiving unit.

Transferring Files to a Computer

Use the TI-Nspire™ software to transfer files and folders from a handheld to a

computer.

1. Connect your handheld to the computer using a standard A to mini-B USB cable.

2. Inthe TI-Nspire™ software, open the Documents Workspace.

3. In the Documents Toolbox, click to open the Content Explorer.

File Management

81



Documents Toolbox

I m

Computer pane

»

Computer

Lookin: |TI-Mspire CX - O

Name & Size

. Dictionary

. Downloads

, Examples

. Images

| Live Presenter Recordings
. MyLib Connected Handhelds pane
, MyWidgets

. Screen Captures
. Stacks

TI-Nspire™ CX Connected Handhelds x

Lookin: |Connected Handhelds ~ | <~

Name ¥
H THNspire CX 1 8FID

4. Inthe Computer pane, navigate to the folder in which you want to save the files.

5. Inthe Connected Handhelds pane, double-click the handheld name to view the
folders and files on the handheld.
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TI-Nspire™ CX Connected Handhelds ~
Lookin: |THNspire CXII8F9D  ~ | i
Name Size
. Examples |~
| MyLib
. MyWidgets
_ Circle_Radi..a_Per_CKins 4 KB _
_ Fountain_Parabolains 2KB [T
~ Getting Started.tns 104 KB
~ ICECreamConetns 4KB
_ MNspireLogs.zip 0KB I
: Solving_Per..sessmentins 3KB -

6. Select the file or folder you want to save to the computer.
e (Click the file to select one file or folder at a time.

e Toselect all files on the handheld, select the first file in the list, hold down the
Shift key, and then click the last file or folder in the list.

e Toselect random files, click the first file, and then hold the Ctrl key while
selecting additional files.

Note: If you select multiple files, it is saved as lesson bundle (.tilb file).
7. Drag the files to the folder in the Computer pane.

—or—

Select File > Save as.

The files are copied to the folder on the computer.

8. Verify that the files you need are available on your computer, and then delete the
files from the handheld.

Note: Those using the TI-Nspire™ CX Premium Teacher Software or the TI-Nspire™ CX
Navigator™ Teacher Software can also use options in the Content Workspace to copy
files from a handheld to a computer.

Resetting the Storage

Complete these steps only if you want to delete ALL files and folders on your handheld.

WARNING: This action clears the copy/paste clipboard, clears Scratchpad, and deletes
all user-created files and folders from the handheld. You cannot undo this operation.
Before proceeding, consider restoring sufficient available storage by deleting only
selected data.
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1. After making certain you want to clear all files, press to open the My
Documents file browser.

2. Press to open the context menu.
3. Select Delete All.

—or—
Press (C].
The Delete All dialogue box opens.
Delete All
This action will clear the copy/paste clipboard,
clear Scratchpad, and all files and folders on

this device. Do you wish to proceed?
o

4. Click OK to confirm that you want to clear the handheld storage.
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Updating the Handheld Operating System

To take advantage of the latest handheld features and updates, download the latest
operating system files from the Education Technology website (education.ti.com). You
can update the operating system (OS) on TI-Nspire™ handhelds using a computer and
the following software:

e TI-Nspire™ CX Premium Teacher Software (v5.0 and later)

e TI-Nspire™ CX Student Software (v5.0 and later)

e TI-Nspire™ CX CAS Premium Teacher Software (v5.0 and later)
e TI-Nspire™ CX CAS Student Software (v5.0 and later)

e TI-Nspire™ CX Navigator™ Teacher Software

e TI-Nspire™ CX CAS Navigator™ Teacher Software

In the classroom, you can use the TI-Nspire™ Docking Stations to upgrade the OS on
multiple handhelds at the same time.

You can also transfer the OS from one TI-Nspire™ handheld to another or from one TI-
Nspire™ CX Il handheld to another. However, handheld operating systems are not
interchangeable. You cannot transfer an Exact Arithmetic or CAS operating system to a
non-Exact Arithmetic or non-CAS handheld and you cannot transfer a TI-Nspire™
handheld operating system to a TI-Nspire™ CX |l handheld.

What You Need to Know

e If there is not enough room on the receiving handheld for the upgrade, a message
is displayed. For more information, see File Management.

e OS upgrade operations do not delete user documents. The only time documents
are affected by an OS installation is if the receiving handheld has a corrupted OS.
In this situation, documents may be affected by OS restoration. It is a good practice
to back up important documents and folders before installing an updated operating
system.

Before You Begin

Before beginning an OS download, ensure that batteries are at least 25 percent
charged.

» To check the status of the rechargeable battery in TI-Nspire™ CX Il handhelds, press
(5] (4] to open the Handheld Status dialogue box.

When in OS download mode, the Automatic Power Down™ (APD™) feature does not
function. If you leave your handheld in download mode for an extended time before
you begin the downloading process, your batteries may become depleted. You will then
need to replace or recharge the batteries before downloading the OS.

Finding Operating System Upgrades

For up-to-date information about available OS upgrades, check the Texas Instruments
website at education.ti.com.
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You can download an OS upgrade from the Texas Instruments website to a computer
and use a USB cable to install the OS on your TI-Nspire™ CX Il handheld. You will need
an Internet connection and the appropriate USB cable to download the updates.

Checking for Handheld OS Updates

When using TI-Nspire™ software, you can quickly determine if your handheld OS is up
to date when the handheld is connected to a computer.

1. Open the TI-Nspire™ software and ensure the handheld is connected to your
computer.

2. Inthe Documents Workspace, click to open Content Explorer.

3. Inthe Connected Handhelds pane, select a connected handheld.

TI-Nspire™ CX Connected Handhelds 3

Look in: |Connec¢edHandheIds v| e

Name

= THNspire CX Il 8F9D

4. Select Help > Check for Handheld/Lab Cradle OS Update.

e If the operating system is current, the Check for Handheld OS Update dialogue
box opens indicating that the operating system on the handheld is up to date.

Check for O5 Update =5

@ Your TI-Mspire CX operating system is up to date.

" J

e |f the operating system is not current, the dialogue box contains a message
indicating that a new version of the operating system is available.

5. To turn off automatic notifications, clear the “Automatically check for updates
checkbox. By default, this option is turned on.

6. Click OK to close the dialogue box.
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Performing the OS Update

In the TI-Nspire™ software, you can select to upgrade the operating system on a
connected hand-held from the following workspaces and menus:

In all versions of the software, you can select Help > Check for Handheld/Lab Cradle
0S Update. Select a connected handheld in the Content Explorer to activate this
option. If the OS on the handheld is not current, the dialogue box indicates that
there is an updated version of the operating system. Follow the prompts to update
the operating system.

In all versions of the TI-Nspire™ software, you can use options available in the
Documents Workspace:

Open Content Explorer, select the handheld name, and then click % and
select Install OS.

—or—

Select Tools > Install Handheld/Lab Cradle OS.

Those using teacher versions of the TI-Nspire™ software can use options available
in the Content Workspace:

In the Resources pane, right-click the name of a connected handheld, and then
select Install Handheld/Lab Cradle OS.

—or—
Select the handheld name in the Preview pane, click "% in the Preview pane,
and then select Install Handheld/Lab Cradle OS.

—or—

Right-click the handheld name and select Install Handheld OS/Lab Cradle OS.

Completing the OS Upgrade

When you select to update the OS on a handheld, the Select Handheld OS File dialogue
box opens.
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%P Select Handheld OS File ==

Lookin: | | Downloads ~| BA®E ||
| &% T-Nspire-5.0.0.1242 1002

File name, |

File ype:  |Handheld OS File -]

[-instanios| | gancel |

The file displayed for selection defaults to the file type required for the selected
handheld.

1. Select the OS file:
e If you are upgrading a TI-Nspire™ CX Il hand-held, select TI-Nspire.tco2

e If you are upgrading a TI-Nspire™ CX Il CAS hand-held, select TI-Nspire.tcc2

e |f you are upgrading a TI-Nspire™ CX II-T (Exact Arithmetic) hand-held, select
TI-Nspire.tct2

2. Click Install OS to download the OS and update the hand-held. The confirmation
message “You are about to upgrade your hand-held operating system. Any unsaved
data will be lost. Do you want to continue?” is displayed.

3. Click Yes to continue.

The Installing OS dialogue box opens indicating the progress of the download. Do
not disconnect the handheld.

Installing OS @

Installing OS...
IMPORTANT! Do not disconnect during OS installation.
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4. When the download is complete, the Information dialogue box opens indicating
that the OS file has been successfully transferred to the handheld. You can
disconnect the handheld.

= The 08 file has been successfully transferred to the handheld
@ The handheld will take a few moments to install the 08 and restart
If you wish, you can disconnect the handheld from the computer now.

5. Click OK.

The updated operating system is installed on the handheld. When the update is
complete, the handheld reboots.

6. On the handheld, follow the prompts to:
e Choose a preferred language.
e Select a preferred font size.

7. When the Welcome screen opens, click OK.
The Home screen opens.

Transferring the Operating System From Another Handheld

Note: You cannot transfer the OS on a TI-Nspire™ hand-held to a TI-Nspire™ CX Il hand-
held and you cannot transfer the OS on an Exact Arithmetic or CAS hand-held to a non-
Exact Arithmetic or non-CAS hand-held. The operating systems are not the same and
are not interchangeable.

To transfer the OS from one handheld to another:
1. Ensure any open documents on the receiving handheld are closed.

Connect the two handhelds using a USB mini-A to mini-B USB cable.

2
3. On the sending hand-held, select Browse from the Home screen.
4

Press menu], and then select Send OS.
On a TI-Nspire™ hand-held, press (menu).

ST NewFolde
fel 2 F:enan‘p;— 4 Size
I“j 4 Collapse T0aK
X 5 Close (Ctrl+W)
> 6 Send B1K
¥ 7 Expand All 17K
= 8 Collapse All . CX e
{} 9 Settings & Status » o
=4 A Send OS

- 104K
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5. On the receiving hand-held, the message, “You are receiving an OS Upgrade.
Unsaved changes will be lost. Would you like to continue?“ is displayed along with
Yes and No response buttons. Select Yes to receive the OS upgrade.

e If Yes is not selected within 30 seconds, the hand-held automatically responds
with No, and the transmission is cancelled.

e |tis important to save and close all open documents before performing an OS
Upgrade. Continuing with an OS Upgrade on a handheld with an open, unsaved
document will cause the loss of that data.

6. While the upgrade is in progress, the following messages are displayed on the
receiving and sending handhelds:

e “Receiving OS. Do not unplug cable.”
e “Sending OS. Do not unplug cable.”

7. After the transfer completes, the sending handheld receives a completion message
and you can unhook the cable. The OS is automatically installed on the receiving
handheld. During the installation process, the “Installing OS <version number>"
message is displayed on the receiving hand-held.

8. When the installation is complete, the “OS <version number> has been installed.
Handheld will now restart.” message is displayed. The restart is initiated. If the
sending handheld is still attached to the cable, the successful transmission
message remains displayed on that handheld’s screen.

Important:

e For each receiving handheld, remember to back up information as necessary and
install new batteries.

e Be sure the sending hand-held is on the Send OS screen.
Upgrading the OS on Multiple Handhelds

In the classroom, use the TI-Nspire™ CX Docking Station to upgrade the OS on multiple
handhelds at the same time.

In the teacher versions of the TI-Nspire™ software, you can transfer files from the
computer to multiple handhelds from the Content Workspace. See Using the Content
Workspace for more information about transferring files to connected handhelds.

OS Upgrade Messages

This section lists the information and error messages that can be displayed on
handhelds during an OS Upgrade.

(S,I:‘?W" Message and Description
Sending “Receiver does not have enough storage space. Make
handheld <xxxK> available.™

This message indicates that the receiving handheld does not have enough
storage available for the new OS. The space requirement is shown so you
know how much storage must be cleared for the new operating system. Files
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Shown

Message and Description

on:
can be moved to a computer for storage to free the necessary space.
Sending “Receiver must change batteries before upgrading the
handheld os. "
This message indicates that the batteries in the receiving handheld need to
be replaced. Send the OS Upgrade once the batteries are replaced.
Sending “Receiver has a newer OS and cannot
handheld load this O0s.™“
OK
This message indicates that the receiving handheld has a newer OS version
than the one being transmitted. You cannot downgrade an OS.
Sending “Upgrade not accepted by receiver.™“
handheld OK
This message indicates that the receiving handheld refuses the upgrade.
Sending “OS has been transferred.
handheld You can now unplug.“
OK
This message indicates that the transfer is complete and it is safe to unplug
the cable from the sending handheld.
Sending “Sending OS. Do not unplug cable.™
handheld This message, along with a progress bar, is displayed while the OS Upgrade is
being transferred.
Both “Transfer failed. Check cable and try again.®
handhelds OK
The sending and/or receiving handheld is not properly connected. Reinsert
the cable into each handheld, and then try the transmission again.
Receiving “You are receiving an OS Upgrade. Unsaved changes
handheld will be lost.
Would you like to continue?"
Yes No
This message is displayed when an OS Upgrade is about to begin. If you do not
select Yes within 30 seconds, the system automatically responds with No.
Receiving “Receiving OS. Do not unplug cable."“
handheld This message, along with a progress bar, is displayed while the OS Upgrade is
being transferred.
Receiving “Installing OS."“
handheld - A - -
This message is displayed when the transfer is complete. It is shown to keep
you informed of the handheld’s status.
Receiving “OS has been installed. Handheld will restart.“
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Shown

Message and Description

on:
handheld OK
This information message displays briefly before the handheld automatically
reboots.
Receiving “Install was corrupted. Handheld will reboot. You
handheld will need to retry OS upgrade.™

OK

An error occurred during the transmission and the installation was corrupted.
The handheld will reboot. After the reboot, reinstall the OS Upgrade.
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TI-Nspire™ CX Il Connect

TI-Nspire™ CX Il Connect is an web-based application that provides connectivity
between a computer and a TI-Nspire™ CX Il graphing calculator. It allows you to
capture the calculator screen, transfer.tns files to and from the calculator, and update
the OS on the calculator.

System Requirements

Browser

- Google Chrome version 90 or later
- Microsoft Edge version 90 or later
Computer

- Chromebook

- Windows® 10

- Mac® 0S 10.15 or later

Active internet connection

Web USB enabled

Access to shared memory, files, and clipboard

Supported Calculators

TI-Nspire™ CX Il
TI-Nspire™ CX Il CAS
TI-Nspire™ CX II-T
TI-Nspire™ CX II-T CAS
TI-Nspire™ CX 1I-C CAS

Getting Started with TI-Nspire™ CX Il Connect

1.
2.

Open a compatible browser.

Enter nspireconnect. ti.cominto the address bar.

If prompted, click Agree and Proceed to accept cookies, and then click ACCEPT
button to agree with the Tl terms and conditions.

A compatibility check will be performed while the application loads. If any issues
are found, a page will display with information on what needs to be addressed.
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TI-72spire™ CX T Connect

Let’s Get Started ~ N

graphing calculator to your

Connect your TI-Nspire™ CX Il
1 computer using the USB cable.

2 CONNECT TO CALCULATOR m

2021 Texas nstruments Incorported. Allghts eservd. | License | Privacy Polcy | Terms f Use

¥ Tous

3. After the Let's Get Started page loads, connect your TI-Nspire™ CX Il calculator to
your computer.

Note: If your computer only has a USB-C port, you will need a USB-A to USB-C
adaptor to connect your calculator.

4. Click CONNECT TO CALCULATOR.
On the pop-up window, click the name of your calculator and then click Connect.

| |
nspireconnect.ti.com wants to connect

Ti-Nspire(tm) CX |l Handheld

° Connect |

The home page will open displaying the three available options: Screen Capture,
File Transfer, and OS Update.
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TI-72spire™ CX I Connect ®

o m S

SCREEN CAPTURE FILE TRANSFER 0S UPDATE

Navigating on the website

There are two ways to navigate on the TI-Nspire™ CX Il Connect website after
connecting your calculator:

e TI-Nspire™ CX Il Connect logo on the top left of each page which links to the home
page

e Links to each function on the top right of each page except the home and Let's Get
Started pages

Note: If your calculator is disconnected and then reconnected (or you connect another
calculator), you will be redirected to the Let's Get Started page.

Using Google Drive

Note: This feature is optional. Tl does not save any of your user data if you sign in with
Google.

To use your Google Drive account to save screenshots or transfer tns files:

1. Click the Sign in with Google icon on the top right part of any page.

@

Sign in with Google

2. On the Sign in with Google pop-up window, complete the sign in process to connect
to Google Drive.
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G Signin - Google Accounts - Google Chrome - o X

@ accounts.google.com/ofoauth2/auth/identifier?radirect_uri=storagerelay%3A%2F%2Fh

G Sign in with Google

Signin

to continue to ti.com

[ Email or phone

Forgot email?

To continue, Google will share your name, email address, language preference, and
profile picture with ti.com. Before using this app, you can review ti.com's

privacy policy and terms of service.

English (United States) ~ Help  Privacy  Terms

3. When prompted on the standard Google Account dialogue, select the tickbox for
the option to grant the application access to your Google Drive for transferring files
to or from your computer.

See, edit, create, and delete only the specific
L Google Drive files you use with this app.
Learn more

After signing successfully, the sign in icon will have a green tickmark and can then
be used to sign out of your Google Drive account.

)

Note: When using Google Drive for screen captures or file transfers, you must
create the folder(s) you want to use in Google Drive first.

Disconnecting TI-Nspire™ CX Il Connect from Google Drive

1. In Google Drive, click the settings icon and select Settings.
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Settings
Get Backup and Sync for Windows

Keyboard shortcuts

2. On the Settings dialogue, click Manage Apps.

3. Locate the TI-Nspire CX Il Connect app in the list and then click OPTIONS >
Disconnect from Drive.

Settings m

General The following apps have been connected to Drive. Connect more apps Learn more
Notifications
Manage Apps
B Cormearsescnets Useby defaut OPTIONS -

E Google Sites Usebydefault  OPTIONS ~
Create and edit stes

Google Slides
Create and edit presentations

TI-Nspire™ CX Il Connect OPTIONS ~

Disconnect from Drive

Usebydefault  OPTIONS

—&  ZIP Extractor
@8 Dpecompress ZIP, RAR, and 7z files to Google Drive

4. On the confirmation dialogue, click DISCONNECT.

| Disconnect app x

TI-Nspire™ CX Il Connect will be discennected from Drive

CANCEL DISCONNECT

The TI-Nspire™ CX Il Connect app will be removed from the list.

5. Click DONE.
Capturing the Calculator Screen

To capture the calculator screen:

1. Navigate to the SCREEN CAPTURE page.
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TI-72spire™ CX I Connect D sceencoone  [pritonser @ osvpasie @

SCREEN CAPTURE

2. Click the CAPTURE SCREEN button.
The current calculator screen will display.

Note: To capture another screen, make the necessary changes on the calculator
and click the CAPTURE SCREEN button again.

3. Click one of the following buttons:

0 - Copies the current screen to the computer clipboard and use the image in

other apps.

& - Saves the current screen to your computer.

# - Saves the current screen to Google Drive.

Note: When using Google Drive for screen captures or file transfers, you must
create the folder(s) you want to use in Google Drive first.

Transferring Files
To transfer files to or from the computer:

1. Navigate to the FILE TRANSFER page.
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TI-72spire™ CX I Connect Bl sceencoune  [prietonsier @ ostoome @

FILE TRANSFER

B0 8

FROM CALCULATOR o CALCULATOR

2. Click either FROM CALCULATOR or TO CALCULATOR and follow the corresponding
instructions below.

Note: Only .tns files can be transferred. Other file types will not be shown. Also,
files on the calculator must be in the My Documents folder, not a sub folder.

Transferring files from the calculator to the computer

Choose the file(s) from the My Documents folder on the calculator that you want to
send to the computer.

Note: Tick or untick the Select All box to highlight or clear the selection of all files.

TI-72spire™ CX I Connect @ sencomne [ Coswene @

« BACK FILE TRANSFER

Choose filefs)from your calculator to send.

TO GOOGLEDRIVE 4 To compuTer ML

To transfer files to Google Drive:

1. Click TO GOOGLE DRIVE.

2. Click on the folder you want to save the files to and click Select.
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Note: When using Google Drive for screen captures or file transfers, you must
create the folder(s) you want to use in Google Drive first.

Note: If you transfer files that already exist on Google Drive, they will be
automatically overwritten.

3. When the Files Sent list appears, you can click SEND MORE FILES or the BACK link to
select more files to transfer.

To transfer files to the computer:

1. Click TO COMPUTER.

2. Click on the folder you want to save the files to and click Select Folder.

3. When prompted to let the site view files, click View files.

4. When prompted to save changes to the destination folder, click Save changes.

Note: If you transfer files that already exist on the computer, a copy of the file will
be created with a number appended to the file name.

5. When the Files Sent list appears, you can click SEND MORE FILES or the BACK link to
select more files to transfer.

Transferring files from the computer to the calculator

1. Click either FROM GOOGLE DRIVE or FROM COMPUTER.

TI-72spire™ CX IT Connect Blscemncwn [» Gosurare @
« BACK. FILE TRANSFER

2. Locate and select the file(s) to transfer.

Note: If you transfer files that already exist on the calculator, a copy of the file will
be created with a number appended to the file name.
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When the Files Sent list appears, you can click SEND MORE FILES or the BACK link to
select more files to transfer.

Note: If you transfer files that already exist on the calculator, a copy of the file will
be created with a number appended to the file name.

On the calculator a prompt will display with the following options:
Open - Opens the file that was transferred.

Go To - Opens the My Documents folder and highlights the file that was
transferred.

OK - Clears the prompt.

Note: If you transfer multiple files the prompt will only apply to the last file that
was transferred.

Updating the OS

To update the OS on the calculator:

1.

Navigate to the OS UPDATE page.

The app will check the OS version on the calculator. If there is a newer version
available, you will be prompted to update.

TI-72spire™ CX I Connect @ srenconre [y retanser @ osvpone @

OS UPDATE

510177

LATEST OS AVAILABLE:

5.3.0.564

2. Click the UPDATE OS button.

A confirmation message will appear when the update is finished.
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General Information
Online Help

education.ti.com/eguide

Select your country for more product information.

Contact Tl Support

education.ti.com/ti-cares

Select your country for technical and other support resources.

Service and Warranty Information

education.ti.com/warranty

Select your country for information about the length and terms of the warranty or
about product service.

Limited Warranty. This warranty does not affect your statutory rights.
Texas Instruments Incorporated

12500 Tl Blvd.

Dallas, TX 75243

Precautions for Rechargeable Batteries

e Do not expose batteries to temperatures above 140°F (60°C).
¢ Do not disassemble or mistreat batteries.

e Use only the charger recommended for the cell or battery, or the one that was
provided with the original equipment.

e Tlrecommends that you use the USB cable included with this calculator. If you
choose to use a third-party power adapter with the Tl-supplied USB cable, you
should use an adapter that meets applicable safety and operational standards and
certifications, including UL and CE certifications.

Take these precautions when replacing rechargeable batteries:

e Replace only with a Tl approved battery.

e Remove the cell or battery from the charger or alternating current adapter when
not in use or being charged.

e Use of the battery in other devices may result in personal injury or damage to
equipment or property.

e Do not mix brands (or types within brands) of batteries. There is a risk of explosion
if the existing battery is replaced by one of the wrong type.
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Disposing of Batteries

Do not mutilate, puncture or dispose of batteries in fire. The batteries can burst or
explode, releasing hazardous chemicals. Discard used batteries according to local
regulations.
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